


Cyclist Mannequin - Siward Vloemans 3Cyclist Mannequin - Siward Vloemans2

Acknowledgements
Project Title
Develop a cyclist mannequin from 3D scans 
for aerodynamics tests.

Student
Siward Vloemans

Supervisory Team
Chair:    Dr. Toon Huysmans
Department: Applied Ergonomics & Design

Mentor:   Ir. Sander Minnoye
Department: Materializing Futures

Master Programme
MSc Integrated Product Design
Faculty of Industrial Design Engineering
Delft University of Technology

Date
February 2022 – July 2022

My master thesis for Integrated Product 
Design was an individual project, but it 
would not have been possible without 
the support of a helpful group of 
people.

First of all, my gratitude extends to 
my supervisory team. Great thanks 
to my chair Dr. Toon Huysmans for 
his digital human modelling expertise, 
helpful feedback and patient support. 
Great thanks to my mentor Ir. Sander 
Minnoye for his advanced manufacturing 
expertise, inspiring coaching and DIY 
bicycle building advice.

Second, my special regards go to 
Bertus Naagen for his knowledge, 
efforts and good company during 3D 
scanning. This project would not have 
been possible without the riders from 
Team DSM who participated in this 
research and performed the physically 
demanding exercises. My special thanks 
also go out to Lies Keijser for the work 
she performed to develop the Generic 
Model and the advice she gave me 
about my project.

Third, I would like to thank Joris van 
Tubergen for his time, expertise and 
motivating conversations with me. I am 
grateful to the PMB staff, specifically 
Don van Eeden, Wiebe Draijer & 
Roland van der Velden, for their 
invaluable support building the full-scale 
mannequin.

Furthermore, I would like to thank 
Harm Ubbens for providing an insight 
into professional cycling. I am also 
grateful to Wouter Terra for providing 
an insight into aerodynamics research. 
Thanks to both for a challenging thesis 
assignment.

Lastly, my personal thanks go to my 
parents Vincent & Esther and to my 
girlfriend Maartje for their feedback on 
my report, motivational conversations 
and support at all times. I could not have 
done it without you.

4. Personalized Mannequin

4.1 Design
4.2 Method

4.2.1 Design Automation
4.2.2 Digital Fabrication
4.2.3 Production

4.3 Development
4.3.1 Product Life Cycle
4.3.2 Function Analysis
4.3.3 How-Tos
4.3.4 Morphological Chart
4.3.5 Concepts
4.3.6 Harris Profile
4.3.7 Concept Redesign

4.4  Design Features
4.4.1 3D Digital Model
4.4.2 Interaction Segmentation
4.4.3 Attachment Interfaces
4.4.4 Bicycle Mounts
4.4.5 Materials & Production
4.4.6 Full-Scale Prototype

4.5  Validation

1. Introduction

1.1  Cycling Aerodynamics
1.2  Problem Definition
1.3  Stakeholders
1.4  Report Structure

Table of Content

3. Generic Model

3.1 Design
3.2 Method

3.2.1 Capture
3.2.2 Process
3.2.3 Correspond
3.2.4 Average

2. Analysis

2.1  Context
2.2 Product
2.3 Competitors
2.4 Dumoulin Mannequin

2.4.1 Description
2.4.2 Interaction Scenario
2.4.3 Evaluation

8

9
10
11
12

13

14
16
18

20
20
21
22

23

24
26
28
30
34
40

43

44
48
49
52
54
56
58
60
61
64
66
72
74
76
78
80
86
94
96
98

108

5. Conclusion

5.1  Recommendations
5.2 Overall Conclusion

113

114
118

7. Appendix

1.  Project Brief
2.  3D Scanning
3.  Interviews
4.  Pressure Cooker
5.  List of Requirements
6.  Personal Reflection

124

126
130
138
141
155
158

6. Sources 120



Cyclist Mannequin - Siward Vloemans 5Cyclist Mannequin - Siward Vloemans4

Summary
The aim of this research is to increase the speed of cyclists by 
reducing aerodynamic drag. Common research methods are 
digital and physical simulations. The goal is this project is to 
develop an anthropometric model for each method based on 
professional cyclists from Team DSM.

Digital Model (Generic)
The first goal of this research is to create a generic cyclist 
model for research organisations around the world. The 
Generic Model is an average of ten male, professional cyclists 
in both road and time trial pose (Figure 0.1). The DINED 
Mannequin approach is used to divide the method into four 
steps: Capture, Process, Correspond & Average.

All participants are captured on-site on personal bicycles 
with two handheld Artec Eva 3D scanners. The 3D scanned 
data is processed in Artec Studio 12 to correct for movement 
and unwanted elements captured during 3D scanning. The 
processed model is corresponded in R3DS Wrap3 with a 
reference base mesh template to make them interpretable 
and to patch missing data. The corresponding models are 
averaged in Paraview to generate the Generic Model.

The Generic Model stays true to the original anthropometric 
data of the participants where possible. However, exceptions 
are made where beneficial to the result. The participants 
are captured in the high-drag leg position with the hands 
separated. Shoes are digitally removed from the model. Hands, 
elbows and inner legs are standardizations because these 
sections are blocked by the bicycle. The base mesh has a 
resolution of 50K uniform, smoothened triangle polygons.

Physical Mannequin (Personalized)
The second goal of this research is to design a personalized 
cyclist mannequin for aerodynamics researchers. The 
Personalized Mannequin is the physical representation of an 
individual cyclist’s anthropometry in time trial pose (Figure 0.2). 
The Centre of Design for Advanced Manufacturing Approach 
is used to divide the process into four steps: Digitalization, 
Design Automation, Digital Fabrication & Production.

The 3D anthropometric data of one of the riders captured for 
the Generic Model is used. Requirements for the mannequin 
are parametrically defined and partially applied in Grasshopper 
(automated) and fully applied in Blender (manually). A full-
scale model of the mannequin is digitally fabricated using 
FDM 3D printing. Loose parts are joined, sanded, finished and 
assembled to complete the prototype.

The requirements and design are the result of an analysis 
phase where users, context, interactions and competitors 
are researched. The creative phase structures and clusters 
challenges and generates solutions to them. The development 
phase continues with the selected concept and researches 
individual design features. The final design is prototyped and 
validated and any recommendations are made last.

Rupert the Personalized Mannequin is CNC milled from rigid 
polyurethane foam. It is segmented near the wrists, upper 
arms and upper legs to apply any cycling gear. SLS 3D Printed 
magnetic, form-fitting interfaces attach the limbs. Rupert is 
mounted to the bicycle on a regular saddle, with cycling shoes 
to the pedals and with flexible hands to the handlebar. Rupert 
has the same surface resolution as the Generic Model.

GenericModelTT-Correction

Figure 0.1: Generic Model of ten male, professional cyclists in time trial pose. Figure 0.2: Personalized Mannequin of an individual male, professional cyclist in time trial pose.



“Around the last left hander with 300 metres to go. Cavendish 
hits the front, Ewan on his wheel, Girmay threatening down the 
middle. Cavendish and Ewan, Ewan hitting the front now and 
Démare down the middle. It’s close between those three.

Oh, that was tight! Oh, that was tight! Démare, Ewan, maybe 
just Ewan. Hard to tell, it is a photo finish between those two.”

Commentator Matt Stephens about Giro d’Italia 2022 Stage 6

Figure 0.3: Cash, D. (2022). [Photograph of cycling photo finish during Giro d’Italia 2022].



9Cyclist Mannequin - Siward Vloemans

1. Introduction
1.1 Cycling Aerodynamics

1.2 Problem Definition

1.3 Stakeholders

1.4 Report Structure

“Cycling races are sometimes won 
by time differences of fractions of 
a second or a few centimetres. For 
instance, Primož Roglič won the 
2019 Tirreno-Adriatico, a seven-day 
race, with only 0.31 s advantage 
to Adam Yates. Kristina Vogel won 
the gold medal in the track cycling 
sprint competition of the Rio 2016 
Olympic Games with only 0.016 s 
and 0.004 s ahead of Becky James, 
in race 1 and 2, respectively. LeMond 
won the 1989 Tour De France in 
87h38m35s, only 8 s ahead of 
Fignon.” (Malizia, 2021).

It is clear that professional cycling 
is truly about marginal gains 
considering the small differences 
on the finish line. As an endurance 
sport at high speeds, small 
factors have a large influence. 
Where the cycling industry was 
previously minimizing weight of 
the riders, bicycles and gear, 
cycling aerodynamics are seeing 
an increased interest in the last 
decades. “Aerodynamic drag is the 
main resistive force a cyclist has 
to overcome, accounting for up to 
90%.” (Grappe et al., 1997).

1. Introduction

1.1 Cycling Aerodynamics
Since aerodynamic optimalization 
has become a focus point in 
cycling, the designs of bicycles and 
equipment have rapidly evolved. 
The most influential factor on 
cycling aerodynamics is the rider 
and his kit, as the bicycle itself is 
only responsible for about 30% of 
the total cyclist-bicycle drag area 
(García-Lopéz et al., 2008). It is the 
reason all cycling garments are skin-
tight and why some gear takes the 
strangest shapes.

The International Cyclist Union 
(UCI) follows the development 
with appropriate regulations, 
banning dangerous methods from 
competition. All of this gear has 
been specifically designed for 
aerodynamic performance and 
tested accordingly (Figure 1.1). 
Aerodynamic research is conducted 
in a variety of methods by bicycle 
manufacturers, research institutes 
and cycling teams alike.

Figure 1.1: Beaumont et al., (2018). [Velocity coloured streamlines for three 
helmets in two different head positions].
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Research institutes, bicycle manufacturers and 
cycling teams are investing in aerodynamics. It 
is the most influencing factor to increase speed. 
The most effective methods are digital and 
physical simulations. Currently, all parties use 
different cyclist models in their simulations. These 
are often personalized models of a 3D scanned 
rider. Because they are all different, research 
results are not directly comparable. A Generic 
Model is the solution to create comparable 
experiments. It generates more knowledge of 
cycling aerodynamics by setting a benchmark for 
all research.

Verification and validation address the concern that 
a model is accurate, as they are only approximate 
imitations of the real world. A mannequin is the 
physical form of a cyclist model and may be used 
to substantiate that the computerized model is 
accurate for its intended application (Sargent, 
2011). Cycling mannequins are used in wind tunnels 
that accurately simulate air flow in the real world, 
vitally important to the wind energy group for 
analysing purposes (TU Delft, n.d.). Live cyclists are 
unable to function as the model subject to produce 
the desired results. A Personalized Mannequin 
is the solution to eliminate movement and other 
variables. The goal is this project is to develop 
an anthropometric model for digital and physical 
simulations based on professional cyclists from 
Team DSM.

For the original Project Brief, refer to Appendix 1.

1. Introduction

1.2 Problem Definition
Digital Model (Generic)
Digital cyclist models are used in numerical 
simulations (Figure 1.2). The first goal of this 
research is to create a generic cyclist model for 
research organisations around the world. The 
model is generated by averaging body geometries 
that are 3D scanned in this project. As cyclist 
models are personalized, they provide insights 
applied to a specific rider. Unfortunately, that 
means the insights are not directly comparable to 
other research and it becomes difficult to relate 
findings. The model must stay true to original 
anthropometric data and providing an accurate 
representation of it.

Physical Mannequin (Personalized)
Physical cyclist mannequins are used in wind 
tunnel simulations (Figure 1.3). The second goal of 
this research is to design a personalized cyclist 
mannequin for aerodynamics researchers. “In the 
last five years it has become common practise to 
use cyclist mannequins in wind tunnels.” (Terra, 
2021). The cyclist mannequin is a proven concept, 
but requires user interaction features to become a 
refined product. It must take multiple rider positions 
and host interactions such as dressing, mounting 
and detaching. Material selection and fabrication 
method are also essential elements in the design 
of such a personalized product.

Figure 1.2: Terra, W. (n.d.). [Visualisation of air flow 
around cyclist model].

Figure 1.3: Terra, W. (2018). [Photograph of cyclist 
mannequin in wind tunnel]. 

Team DSM – Harm Ubbens
Professional cycling Team DSM is a client in 
this project. Harm Ubbens is Team DSM’s 
aerodynamics expert. The team was previously 
involved in the development of the Dumoulin 
Mannequin and is now looking to develop the 
product. Team DSM supports this project with a 
budget for the Personalized Mannequin. All riders 
3D scanned in this project are supplied by them.

1. Introduction

1.3 Stakeholders
Monash University
Frequently collaborating with the Australian Cycling 
Federation, Monash University is working with 
Wouter Terra to research cycling aerodynamics. 
Monash has a research group with access to 3D 
scanned track cyclist geometry and is working 
in parallel with this project to generate a Generic 
Model. The research group supports this project 
by sharing knowledge about the model and by 
performing aerodynamic validation when it is done. 

Fieldlab UPPS
As an Ultra Personalized Product and Service, the 
cycling mannequin project is connected to Fieldlab 
UPPS. The Fieldlab supports this project with a 
budget for the Personalized Mannequin prototype. 
An assistant hired to process the 3D scans for the 
Generic Model by Fieldlab UPPS as well.
 

Bertus Naagen
Bertus Naagen manages the Body Lab at the 
faculty of Industrial Design Engineering and is the 
expert involved in 3D scanning all the riders.

Lies Keijser
Lies Keijser is an Integrated Product Design 
graduate hired by Fieldlab UPPS to perform Digital 
Human Modelling work on the Generic Model 
during this project.

Model Making Machine Lab
The PMB, or Model Making Machine Lab, is the 
workshop at the faculty of Industrial Design 
Engineering where the Personalized Mannequin is 
produced. 

Joris van Tubergen
Joris van Tubergen is an expert in FDM 3D printing 
on a large scale and was previously involved in the 
development of the Dumoulin Mannequin.

Figure 1.4: Team DSM. (n.d.). [Logo of Team DSM].

Wouter Terra
Wouter Terra is also a client in this project. He is 
NOC*NSF’s embedded scientist aerodynamics 
from TU Delft. Terra received his PhD for Particle 
Image Velocimetry (PIV) research in the wind 
tunnel and is now looking to develop a broadly 
applicable cyclist model. He was previously 
involved in the development of the Dumoulin 
Mannequin. Wouter Terra supports this project with 
a budget for the Generic Model. All contact with 
Monash University is also managed by him. 

Figure 1.5: Fieldlab UPPS. (n.d.). [Logo of Fieldlab 
UPPS].
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This report consists of seven chapters in total: Introduction, Analysis, Generic 
Model, Personalized Mannequin, Conclusion, Sources & Appendix. This is the last 
page of the first chapter Introduction. The last chapter is the Appendix. A visual 
overview of the report is described in the Table of Content on page four.

Chapter 1: Introduction opens the report by explaining the topic of cycling 
aerodynamics and this is the last page of the chapter. Chapter 2: Analysis is 
the first chapter to discuss content of this project being the research phase. 
It describes the Context, Product & Competitors and dives deeper into the 
Dumoulin Mannequin, the predecessor of this project.

The body of this report is chapter 3: Generic Model and chapter 4: Personalized 
Mannequin. They are structured similarly, showing the design result first and 
then elaborating on the method used. The Personalized Mannequin is discussed 
more extensively by following up with chapters about its Development, Design 
Features and Validation of its design.

Chapter 5: Conclusion starts by giving Recommendations based on results of 
the Validation chapter. The report is rounded up by giving an Overall Conclusion. 
Chapter 6: Sources describes all references made in the report. Chapter 7: 
Appendix includes any extra content not directly discussed in the report. It is the 
last chapter in this report.

1. Introduction

1.4 Report Structure
1. Introduction

2. Analysis

3. Generic Model

4. Personalized Mannequin

5. Conclusion

6. Sources

7. Appendix 2. Analysis
2.1 Context

2.2 Product

2.3 Competitors

2.4 Dumoulin Mannequin
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Udiam restruptas nis et, consequis eicaboritate 
ex explaut perio. Optibus, asiti quam volut volorita 
vendit a corem vellandis dis andeliq uosamus, sunt 
ullupta taturia voleniet aut alis molupta tenisitassi 
consed utem eum alignam aut omnimus, optatem 
porest eiuntiu sanimus eaquam nobit eatius idis 
di as a porem volorrum quaectorro bea dolorum 
eture, sunt ero mod molorro optaspe assus dem 
aped modio quodis aut impor si in consequae. 
Et maximpo rrorrum que si denim ex exerum 
excepelesed ut a debita nonecto evendit, sam aut 
reperios mi, nonse vellore pudandus netur minctur 
sintiatur re vellandia dent ut officipsae laborem 
delessi mpedipiciam entem lant, experum etur sam 
que aliatiatem cusandebis ium aciissi nveliqui aut ad 
ut od eum harum que ommo dolupit di odita si tem 
cum anditibea eveliquamus asperoratur maximin 
recesti nonsedici rae volupti ateceat esendant 
plitatem eaqui aut inciuntore rerovitia venem aut 
eliatetur?

Boventitel

Ondertitel
Open Jet Facility visit and interview with TU 
Delft’s PhD aerodynamics expert Wouter Terra on 
Monday 21-02-2022.

What is the OJF?
The Open Jet Facility (OJF) is a low-speed wind 
tunnel at the faculty of Aerospace Engineering 
at TU Delft. It is an impressive facility situated in 
a large room of 13 meters in width and 8 meters 
in height, able to handle very large models that 
obstruct airflow considerably (Figure 2.1).

2. Analysis

2.1 Context

Why to use the OJF?
For some purposes such as testing with large 
objects, a large wind tunnel is required. There is no 
other wind tunnel this size in Delft. Such tunnels are 
suitable for objects with up to 5% of its test section 
surface size (0,4 m2).

A wind tunnel can simulate reality, but allows to 
test in controlled conditions. In this way, research is 
repeatable by accurately describing conditions.

How to use the OJF?
The facility itself is a wind tunnel and only that. 
This means you can only influence wind speed. 
Temperature and other factors are negligible. To 
test air resistance of a rider or any other values, an 
additional setup is required.

Drag of a cyclist is measured using a special scale 
developed by the Netherlands Aerospace Centre. 
Any such setups are placed on the platform, 
lowered flush to ‘ground level’. Bicycles are 
typically fixed with a connected stand. The scale 
measures the effect of wind on the bicycle and 
rider. It automatically calculates the air resistance. 

The bicycle may face straight into the orifice to 
simulate head winds (Figure 2.2), but it may also 
be rotated to simulate side winds. Winds speeds 
typically reach up to around 50 km/h. The bicycle-
rider setup may wobble at such speeds, so the 
mannequin must be attached firmly.

Measurements in the OJF wind tunnel are 
never 100% accurate. Wouter typically repeats 
measurements five times to gain accurate results.

How is PIV applied in the OJF?
Particle Image Velocimetry (PIV) is an age-old 
technique, but only until recently applied in cyclist 
aerodynamics research. It requires thousands 
of tiny ‘weightless’ bubbles to capture air flow. 
The development of such enabling devices was 
the bottleneck in this process. The bubbles must 

Figure 2.1: TU Delft. (n.d.). [Schematic of OJF].

reflect light created by a laser in order to be 
captured by cameras. In turn, the mannequin 
must absorb light not to hinder the cameras. It is 
therefore preferably coloured matte black.

Since the development has progressed, 
PIV is seeing increasing application in cyclist 
aerodynamics research. It is able to not only 
measure performance, but to explain it too. 
However, PIV is expensive so traditional wind 
tunnel testing is still the norm.

Repeatability in the OJF?
To perform comparable measurements, a 
test setup must be repeatable. Wind tunnels 
sometimes feature a green screen with cameras 
capturing the test subject. It allows visual 
adjustment of the subject. The OJF uses cameras 
installed in the ceiling and markers on the subject 
to accurately calibrate the setup.

Figure 2.2: Terra, W. (2018). [Photograph of 
Dumoulin Mannequin in Open Jet Facility]. 

Figure 2.3: Terra, W. (2018). [Photograph of Dumoulin Mannequin in Open Jet Facility with annotations]. 

The Wind Tunnel in Overview

The orifice of the wind tunnel.

The Dumoulin Mannequin.

Stands keep the bicycle upright.

The scale is integrated with the floor.
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Team DSM facility visit and interview with Team 
DSM’s aerodynamics expert Harm Ubbens on 
Wednesday 10-02-2022.

Position
The mannequin serves as the replacement subject 
of the rider. It is used only to test rider and bicycle 
equipment, such as helmets, suits and wheels. 
It is not used to test body poses. However, it is 
required that the mannequin can be used on both 
a time trial (Figure 2.7) and a road bike (Figure 
2.8) in corresponding poses. The mannequin 
principally requires no movement on the body in 
joints or limbs. It would be valuable if it were able 
to pedal (motorized), but that is no deal-breaking 
requirement. Generally speaking: the more moving 
parts, the less stable the mannequin and the less 
accurate the measurements.

2. Analysis

2.2 Product

Attachment
The mannequin must be rigid and stable on the 
bicycle, but practical in use. It must therefore 
utilize the three primary body attachment points 
to the bike: feet to pedals, bottom to saddle and 
hands to handlebar. The elbows also rest on the 
handlebar in time trial position (Figure 2.4). The 
saddle is the most important attachment point, 
as it carries the most weight. It is also the most 
challenging point, as the legs are close together 
and cycling shorts have a cushion (Figure 2.5). 
The cleats on cycling shoes could be used to 
attach to pedals (Figure 2.6). The hands are more 
challenging and cycling gloves are therefore 
avoided with these mannequins.

Figure 2.4: The Dumoulin Mannequin’s hands are 
placed around the handlebars.

Figure 2.5: The Dumoulin Mannequin has a small 
contact area with the saddle.

Figure 2.6: The Dumoulin Mannequin’s feet are not 
easily attached to the pedals.

Limbs
A cycling mannequin consists of multiple pieces 
because of practical reasons in handling. It must be 
stored, transported and most importantly dressed. 
A cycling suit is made in one piece, so it is not 
easily applied. Generally, the legs and arms are 
separate from the torso and sometimes the head 
too. The mannequin model is preferably ‘nude’, so 
it can be tested with all sorts of apparel. As the 
mannequin must be unmounted from the bicycle 
and its limbs detached for every outfit, a quick and 
easy interaction is required.

Figure 2.7: Sportfoto. (2021). [Photograph of cyclist Esmee Peperkamp on time 
trial bike].

Figure 2.8: Scott. (2021). [Photograph of Team DSM cyclist on road bike].
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Personalized cycling mannequins are modern tools 
seeing increasing popularity. In recent years, a few 
mannequins have been modelled after professional 
riders. This competitor analysis provides an 
overview of personalized cycling mannequins 
and their specifications. The goal is to learn from 
the competitors, applying successful features 
and improving where possible. Desk research is 
performed to make the analysis and all sources 
are mentioned in the overview (Figure 2.11).

Professional Cyclist Mannequins
The overview of personalized mannequins based 
on a professional cyclist shows a development in 
the past decade and a variety of product features. 
The mannequins mostly vary in terms of fabrication 
method and special features. All except one 
example are in private ownership. 

Other Cyclist Mannequins
Vorteq and Voxdale show a development into 
commercial application and fully articulating limbs. 
As recent innovations, these examples serve as 
the most relevant competitors to this project. 
The Vorteq and Voxdale mannequins are briefly 
described in the following section. The Dumoulin 
Mannequin is an older example created and used 
by the case owners of this project. The mannequin 
is accessed in this project and described more 
extensively on the following pages.

2. Analysis

2.3 Competitors

Vorteq
Since 2018, Vorteq is the only company to 
commercially produce personalized cyclist 
mannequins (Figure 2.9). Based in Silverstone 
Sports Engineering Hub, Vorteq has access to an 
open-jet, closed-end wind tunnel. With 12 Raise 3D 
Pro printers, they are able to fabricate mannequins 
within 24 hours. Mannequins are available in three 
configurations with different features (Vorteq, n.d.).

Voxdale
In 2020, Raman Garimella published a scientific 
report about the development of an articulating, 
personalized cycling mannequin (Figure 2.10). 
Working together with the University of Antwerp 
and TU Delft, an elite cyclist was 3D scanned and 
processed. The 3D model features both road and 
time trial bicycle poses. The mannequin features 
articulating limbs to realize the 360˚ pedal stroke  
(Garimella et al, 2020).

Figure 2.9: SSEH. (n.d.). [Photograph of static 
cyclist mannequin in wind tunnel].

Figure 2.10: Garimella, R. (2020). [Photograph of 
articulating cyclist mannequin].

Rider

Organisation

Year

Fabrication

Features

Hands

Feet

Saddle

Source

Grischa Niermann

Giant Bicycles

2010

FDM 3D Printing

Articulating limbs
Multiple positions

Open hands

Cycling shoes

Custom mount

Giant Bicycles, n.d.

Tom Dumoulin

TU Delft

2016

FDM 3D Printing

Resolution

Open hands

Integrated shoes

Regular saddle

TU Delft, 2016

Chris Froome

TU Norway

2017

FDM 3D Printing

White colour

None

Integrated shoes

Regular saddle

Norwegian 
SciTech News, 
2017

Tony Martin

Bike Valley

2017

CNC Milling

Fibreglass layer
Knee joint

Rounded

Custom mount

Regular saddle

Cycling Weekly, 
2017

Anyone

Vorteq

Since 2018

FDM 3D Printing

Magnetic limbs
Disc joints

Bolted hands

Cycling shoes

Custom mount

Silverstone Sports 
Engineering Hub, 
2020

Van Aert & Roglic

TU Eindhoven

2020

Gel casting

Smooth coating
Skin colour

Closed hands

Cycling shoes

Regular saddle

Team Jumbo-
Visma, 2021

Elite cyclist

Voxdale

2020

FDM 3D Printing

Articulating limbs

Open hands

Cycling shoes

Custom mount

Garimella et al, 
2020

Figure 2.11: Overview of competitor personalized cycling mannequins and their features. 
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Udiam restruptas nis et, consequis eicaboritate 
ex explaut perio. Optibus, asiti quam volut volorita 
vendit a corem vellandis dis andeliq uosamus, sunt 
ullupta taturia voleniet aut alis molupta tenisitassi 
consed utem eum alignam aut omnimus, optatem 
porest eiuntiu sanimus eaquam nobit eatius idis 
di as a porem volorrum quaectorro bea dolorum 
eture, sunt ero mod molorro optaspe assus dem 
aped modio quodis aut impor si in consequae. 
Et maximpo rrorrum que si denim ex exerum 
excepelesed ut a debita nonecto evendit, sam aut 
reperios mi, nonse vellore pudandus netur minctur 
sintiatur re vellandia dent ut officipsae laborem 
delessi mpedipiciam entem lant, experum etur sam 
que aliatiatem cusandebis ium aciissi nveliqui aut ad 
ut od eum harum que ommo dolupit di odita si tem 
cum anditibea eveliquamus asperoratur maximin 
recesti nonsedici rae volupti ateceat esendant 
plitatem eaqui aut inciuntore rerovitia venem aut 
eliatetur?

Boventitel

Ondertitel
The Dumoulin Mannequin description and 
evaluation is based on interviews with Team 
DSM’s aerodynamics expert Harm Ubbens on 
Wednesday 10-02-2022 and TU Delft’s PhD 
aerodynamics expert Wouter Terra on Monday 
21-02-2022.

Description
A life-size mannequin of Tom Dumoulin (Figure 
2.12) is created in 2016 as part of a research by 
the TU Delft Sports Engineering Institute. The 
mannequin allows unlimited access to an athlete’s 
geometry in order to conduct extensive wind 
tunnel tests. The Dumoulin Mannequin is used to 
develop a time trial suit and has been a valuable 
tool for cycling Team DSM. It is one of the first 
personalized cycling mannequins in the world and 
only a handful have followed since.

Tom Dumoulin is professionally scanned by Th3rd 
in a scan studio with 130 DSLR cameras. The 
studio captures humans in high resolution in a 
second. Th3rd processed the digital model. The 
mannequin is designed and made by IDE students 
in four months. The 3D printing method is chosen 
deliberately to research its large-scale capabilities.

Features
 • High resolution model and smooth surface.
 • Matte black colour for PIV testing.
 • Limbs connect with nuts and bolts.
 • The 3D printed shoes attach to pedal cleats.

2. Analysis

2.4 Dumoulin Mannequin

Figure 2.12: Vos, C. (2016). [Dumoulin Mannequin in Open Jet Facility].
Figure 2.19: The back is added last after all limbs 
are secured. 

Figure 2.20: The mannequin now rests on the 
bicycle in four places.

Figure 2.13: The bicycle is easily installed in a fixed 
stand.

Figure 2.14: The suit is most challenging to handle 
and has to be applied first.

Figure 2.15: Some connection points are broken, so 
duct tape is used as an alternative.

Figure 2.16: The Dumoulin Mannequin’s hands are 
placed around the handlebars.

Figure 2.17: The legs are attached to the body, but 
do not actually connect to the pedals.

Figure 2.18: Limbs are manually secured to the 
torso with integrated nuts and bolts.

Interaction Scenario
Harm Ubbens performs the interaction 
of assembling and mounting the 
Dumoulin Mannequin to a bicycle. The 
interaction is always involved multiple 
times when testing with the mannequin.
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User Evaluation
Since the research project by TU Delft, the Dumoulin Mannequin served for 
about five research sessions by Team DSM from 2016-2022. The mannequin 
is discussed during interviews with Harm Ubbens and Wouter Terra. Both used 
the mannequin in the wind tunnel and provide feedback based on personal 
experiences to improve its design. The results are clustered and listed below.

Overall
 • The mannequin has produced great test results.
 • It has proven a useful tool in aerodynamics research.
 • It has a good level of detail, but lacks in engineering and user interaction.

Apply cycling gear
 • The shoes are 3D printed with the body.
 • Cycling suits are difficult to apply and the fragile zippers sometimes break.
 • Some believe that tight, aerodynamic suits stretch over time and become 

useless. Easy application is essential.

Connect limbs
 • Connection pieces are broken (Figure 2.21).
 • Difficult to connect with nuts and bolts (Figure 2.22).
 • Mannequin configuration is challenging to restore as joints allow rotation.

Mount to bicycle
 • Due to its stiffness, the mannequin can only mount to the bike in a single 

configuration. It is difficult to mount, but easy to reproduce.
 • During the first use-case, the model fit well with the bicycle. It mounted to 

the pedals using cleats.
 • During later use-cases, the model did not fit correctly with the bicycle. 

Bicycle configuration may have changed and could not be restored.
 • Attached to the bicycle with tie-wraps.

Durability
 • The mannequin may have deformed during storage in a hot environment 

(40˚C). One leg seems to be twisted.
 • A storage solution would be useful.
 • It is now at the end of its life and has become too fragile.

Figure 2.21: Elements connecting limbs have become too fragile and duct tape is 
used instead.

Figure 2.22: Limbs are connected to the torso using nuts and bolts, the back 
piece is attached last.

3. Generic Model
3.1 Design

3.2 Method
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The first goal of this research is to create a 
generic cyclist model for research organisations 
around the world. The Generic Model represents a 
population of professional road cyclists to replace 
personalized models in aerodynamics research. It is 
generated from 3D scanned anthropometric data 
of ten male road cyclists from Team DSM. The 
Generic Model is as realistic as possible, although 
some modifications are used to improve its quality. 
Environmental elements and double surfaces are 
removed from the 3D scan. Standardizations are 
applied to the hands, elbows and inner legs to 
compensate for missing data. The base mesh has 
a resolution of 50K uniform, triangle polygons and 
is smoothened to eliminate noise.

The Generic Model is of value in digital simulations 
in the research of cycling aerodynamics. It 
generates knowledge not only applicable to 
an individual, but to the whole professional 
cycling population. The model is going to be 
shared publicly, so anyone has access to it. 
Research becomes directly comparable when 
several parties use the Generic Model in their 
simulations. It generates more knowledge of 
cycling aerodynamics by setting a benchmark for 
all research.

3. Generic Model

3.1 Design
Standardization
Hands accurately standardized.
Shoes replaced with bare feet.
Bicycle mounts digitally removed.

Position
High-drag leg position.
Aerodynamic competition pose.
Hands separated on time trial bars.

GenericModelTT-Correction

GenericModelTT-Correction

GenericModelTT-Correction

Resolution
High resolution mesh.
Uniform, triangle polygons.
Smoothened surface eliminates noise.

Procedure
Wearing Team DSM cycling kit during 3D scan.
Wearing head cap instead of helmet.
3D Scanned on personal bicycle.

The Model
In Six Questions

Who?
Sports aerodynamics expert Wouter 
Terra and other aerodynamics 
researchers & institutes.

What?
Using a generic cyclist model for 
aerodynamics research to compare 
cycling gear for both rider and bicycle.

Where?
In digital simulation software used 
worldwide.

When?
During the digital simulation phase of 
aerodynamics research projects.

Why?
First, to generate comparable results 
between different researchers by 
eliminating a variable.
Second, to generate representative 
results for a larger population.

How?
A personalized cyclist model is 
replaced by a generic cyclist model 
during aerodynamics simulations.

GenericModelTT-Correction

GenericModelTT-Correction
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3. Generic Model

3.2 Method
Based on the DINED Mannequin (Huysmans et al, 
2020), the method for the Generic Model is divided 
in four sections: Capture, Process, Correspond & 
Average. Additionally, a base mesh is required as 
input to the corresponding workflow. The last two 
sections of the method are iterative, removing 
reference bias by continuously iterating on the 
base mesh. The workflow is based on an interview 
with Toon Huysmans included in Appendix 3.2. 
Work on the Generic Model is performed in 
collaboration with Monash University. The workflow 
is improved several times in discussion with the 
research group working with anthropometric data 
of Australian track cyclists. The goal is to eventually 
combine the work and to publish about generation 
and validation of the Generic Model together.

Figure 3.1: Capturing rider using 3D scanner. Figure 3.2: Processing model in Artec Studio 12.

Capture
The riders are 3D scanned to capture their 
anthropometric data. All participants in this 
research are captured on site, so portable 
handheld Artec Eva 3D scanners are used (Figure 
3.1). Captured data is only a random collection of 
points and must be processed before it is usable.

Process
The captured data is processed in Artec Studio 12 
(Figure 3.2). Any unwanted elements such as the 
bicycle are erased. Scan sections are aligned and 
excess information is removed. All points are fused 
into a single model.

Figure 3.3: Corresponding model in R3DS Wrap.

Landmarks

Figure 3.4: Averaging model in Paraview.

Correspond
The processed data is corresponded in R3DS 
Wrap3 (Figure 3.3). A base mesh template is used 
to make the model interpretable. It is applied to 
the model by pairing landmarks to a template. The 
base mesh replaces any missing data and gives 
the model a smooth surface.

Average
The corresponding models are averaged in 
Paraview (Figure 3.4). A mean average is calculated 
based on the mesh applied to the models. The 
average model is also smoothened to compensate 
for inaccuracies.

Research
Ethics
Due to the highly personal data 
acquired during this research, data 
protection is a priority. The research 
proposal is approved by the Ethical 
Committee of the TU Delft. The 
participants are given full disclosure 
and anonymity. Only anonymised or 
aggregated data will be shared with 
others. The following steps are taken 
to protect the data of the participants 
involved:

Participants are briefed beforehand.

Participants sign informed consent form.

Data stored anonymously.

Data stored on secure server.

Back-up is kept on remote hard drive.

Screenshots only of mannequin model.

Dataset
Ten professional male cyclists of Team 
DSM are 3D scanned in this project. The 
group includes riders from six nationalities 
and varying cycling expertise: General 
Classification, Sprinters, Time Trialists, 
Punchers and Classics. All participants are 
captured in road, time trial and standing pose.

Mean age:  19.7 years
Mean height: 182.0 cm
Mean mass: 71.0 kg
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3.2 Generic Model: Method

3.2.1 Capture
All participants in this research are captured on 
site, the Keep Challenging Center in Sittard in this 
case. This involves a number of challenges, mainly 
that portable 3D scanners are required where a 
full-body setup would have otherwise been used 
(Figure 3.5). Two Artec Eva handheld 3D scanners 
are used to scan the participants from the left and 
right side. The capturing process is performed 
together with TU Delft’s 3D scanning expert Bertus 
Naagen.

A pilot is performed to prepare the research 
method (Appendix 2.1). Improvements are 
implemented and concern primarily clear stimuli to 
the participants, so they all strike an identical pose. 
All participants are briefed at least one day ahead 
of the session (Appendix 2.2). Two sessions are 
performed to capture a total of ten riders. All riders 
sign an informed consent form (Appendix 2.3). The 
participants are captured in standing, road and 
time trial pose on their personal bicycles.

The 3dMD full-body 3D scanner of the Body Lab 
at the faculty of Industrial Design Engineering 
captures models of superior quality to the Artec 
Eva handheld 3D scanner. It captures the subject 
from all angles in a moment, so movement does 
not impact the model. However, the participating 
riders of Team DSM are unable to visit the facility 
due to busy schedules during the cycling season. 
Using the Body Lab is therefore not an option.

Figure 3.5: Capturing a participant in the Body Lab using a handheld 3D scanner.

Participants
A variety of about 20 male, professional cyclists 
from Team DSM participate in this research. During 
the first session, five riders are 3D scanned.

Apparatus
 • Time trial bicycle (rider-specific)
 • Road bicycle (rider-specific)
 • Cycling kit (rider specific)
 • Bicycle trainer stand

 • Artec Eva 3D handheld scanner (2x)
 • Laptop with Artec Studio 16 software (2x)
 • Cable reel (2x)
 • Trolley table (2x)

 • Portable hard drive
 • Head caps
 • Balance bar
 • Anthropometer

Stimuli
The participant is asked about personal 
demographics. The questions include: gender, age, 
ethnicity, cycling type, length, weight, kit size, and 
shoe size. Furthermore three body measurements 
are taken.

Shoulder breadth (biacromial)
Horizontal distance between shoulder joints.

Hip circumference
Maximum circumference of the hip.

Thigh circumference
Maximum circumference of the thigh.

The participant is positioned in cycling kit. The 
participant is instructed to remain still while being 
captured by the researchers for about 5 minutes. 
This research involves three poses:

A-pose standing up
Feet separated, positioned below shoulders.
Arms separated, holding balance bar ends.
Wearing no shoes. Wearing socks.

Riding pose on time trial bicycle (Figure 3.6)
Shoes clipped into pedals.
Left leg stretched, right leg retracted.
Hands separated on time trial bar ends.
Elbows in time trial bar rests.
Wearing no helmet. Wearing head cap.

Riding pose on road bicycle (Figure 3.7)
Shoes clipped into pedals.
Left leg stretched, right leg retracted.
Hands deep in handlebar drops.
Wearing no helmet. Wearing head cap.

Procedure
Location: Keep Challenging Centre, Sittard.
Time: 11:00-16:00 (60 minutes per participant).

Introduction
1. Participant is introduced to the research.
2. Participant reads and signs informed consent 

form.
3. Participant changes into cycling kit.

Preparation
4. Participant is asked about personal 

demographics.
5. Participant’s body measures are taken.
6. No anatomical markers are applied to the 

participant.
7. Participant’s bicycle is installed in stand.

 
3D Scanning

8. Participant enters scanning setup (bicycle or 
empty floor).

9. Participant cycles for 2-3 minutes to feel 
natural pose.

10. Participant strikes selected pose.
11. Participant’s 3D model is captured by the 

researchers from left and right side.
12. Process is repeated for remaining poses.

Processing
13. Researchers confirm captured 3D model for 

quality.
14. Raw 3D scan data is stored on portable hard 

drive with correct name.
15. Participant is asked about their experience 

and questions.
Figure 3.6: BELGA. 
(2021). [Photograph of 
cyclist Cees Bol during 
time trial].

Figure 3.7: Team DSM. 
(2021). [Photograph 
of Tim Naberman in 
drops].
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3.2 Generic Model: Method

3.2.2 Process
The data captured by the Artec Eva 3D scanners is 
a raw point cloud and requires processing before it 
can be used. The Artec Studio 12 software (Artec 
3D, 2017) is used to clean up the 3D scan, fuse 
points and combine both halves. The workflow is 
established in collaboration with Bertus Naagen 
and Lies Keijser.

The final results show gaps where the bicycle 
blocks the 3D scanner’s lens, most notably around 
the inner legs, hands and face. Other inaccuracies 
occur near dark or reflective materials which 
the 3D scanner fails to capture. The quality of 
the model is also influenced by any movements 
of the participant, which are unavoidable on a 
bicycle. The road bicycle in particular is challenging, 
because it does not have elbow rests.

Processing the captured models is a time 
consuming task due to the quality of the 3D scans. 
The handheld Artec Eva 3D scanners produce a 
result of lower quality than the 3dMD full-body 
3D scanner of the Body Lab. Incompleteness and 
movements are the main limitations. The full-body 
3D scanner is preferable in this scenario as the 
scans are of superior quality and they are faster 
to capture and process. However, all participants 
must visit the faculty to use the full-body set-up 
as it is not portable. That involves bringing all gear 
such as the cycling kit and both personal bicycles 
for each participant. The Artec Eva handheld 3D 
scanners are used as logistic limitations did not 
allow the participants to visit the IDE faculty.

Figure 3.8: The raw scan data contains gaps and environmental elements. Figure 3.9: Unwanted, selected elements appear in 
red before erasing.

Figure 3.10: Registration tools automatically 
optimize the scan data.

Figure 3.11: Create a polygonal 3D model using 
Fusion to unify half the body.

Half 3D Scan
Each halve must first be processed individually as 
the subject is 3D scanned in two halves.

File > Open Project
Open raw 3D scan data. The model is still a 
random point cloud at this moment and loose 
sections are floating around each other (Figure 
3.8).

Editor > Eraser
Remove unwanted elements. Mainly the bicycle is 
erased from the 3D scan, but contact points with 
the bicycle are also cleaned up (Figure 3.9). Elbow 
supports must be completely invisible, for example.

Tools > Registration
Adjusting and optimizing frames. Scan sections 
are automatically aligned, but may need manual 
adjustment for an accurate results (Figure 3.10). 
Any double or non-aligned data is excluded from 
the model.

 • Rough Serial Registration
 • Fine Registration
 • Global Registration

Tools > Smooth Fusion
Smooth Fusion is useful for scans of moving 
objects with patchy missing regions. Hole filling 
is applied with a threshold of 10 mm. The loose 
sections of the model are joined at this point 
(Figure 3.11).

File > Export Meshes
Store processed half 3D scan data in OBJ format. 
Confirm the model for no floating points, double or 
deformed surfaces.
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Figure 3.12: The second half is added, but needs 
position adjustment.

Figure 3.13: Align tools automatically pair scans 
and can be repeated for better results.

Figure 3.14: Create a polygonal 3D using Fusion to 
unify the body halves.

Full 3D Scan
The halves must be combined after initial 
processing to create a complete 3D scan model.

File > Import
Open processed half 3D scan data. Two halves of 
the model are oriented randomly (Figure 3.12).

Align > Automatic
Assembling scans. The software automatically 
aligns the scans, but sometimes needs manual 
adjustment (Figure 3.13). The non-rigid alignment 
is applied as compensate for small differences 
between the halves.

 • Best Fit
 • Non-Rigid

Tools > Smooth Fusion
Smooth fusion compensates for slight movements 
by the participant. The halves of the models are 
joined at this point (Figure 3.14).

File > Export Meshes
Store processed 3D scan data in OBJ format. 
Confirm the model once more for no floating 
points, double or deformed surfaces.

Evaluation
The resulting processed model clearly shows 
where data is missing. The hands, elbows, shoes 
and inner legs are incomplete. The goal is to avoid 
holes where possible as they must be filled in the 
following steps. A complete model means less 
work patching holes and a result closer to reality. 
Multiple factors influence the quality of this model.

Some holes are unavoidable. The main obstruction 
in this context is the bicycle of the participant. 
Contact points with the bicycle block parts of the 
body such as the hands, elbows and bottom. The 
bicycle’s top and downtube furthermore block 
parts of the inner legs (Figure 3.15).

Another limitation is the black Team DSM cycling 
kit the participants are wearing. While it does not 
give any difficulties in most areas, the dark bib 
of the shorts and glossy soles of the shoes are 
challenging to capture. This is caused by the 3D 
scanner struggling to capture non-reflective or 
extra-reflective surfaces.

3D Scanning a cyclist takes about five minutes, 
meaning the participants must hold their pose 
for a significant amount of time. The cycling 
position is challenging to hold as the legs are 
normally pedalling, applying downward pressure 
and balancing the body. The 3D scan results are 
compromised because the participants make small 
movements during the process, specifically on the 
road bike which has no elbow rests.

Figure 3.15: The processed model shows holes near areas that are challenging to capture.

The Processed Model in Overview

The hands are incomplete.

The elbow rests block parts of the arm.

The bicycle obstructs the inner legs.

The reflective soles are not captured.
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3.2 Generic Model: Method

3.2.3 Correspond
The 3D model resulting from processing in Artec Studio 12 can be edited in any 
CAD software, but must be corresponded to be recognized as a human body 
instead of a random shape. The R3DS Wrap3 software (Russian3DScanner LLC, 
2021) is used to wrap a base mesh around the 3D model (Figure 3.16). A set of 
landmarks is identified to pair the model to a template. The base mesh template 
determines the level of details and defines numbered vertices. Each vertex 
number eventually corresponds to an identical anatomical location for every 
corresponded model. Parts of the 3D models are excluded from the process 
as original data lacks. Hands, elbows, feet and inner legs are normalized by the 
software.

1. Load & Repair
Base mesh template and processed cyclist model are loaded in R3DS Wrap3. 
Any singular vertices or non-manifold edges are automatically removed. All 
components other than the models itself are also removed.

2. Pair & Wrap
A set of 47 landmarks are applied to the base mesh template to identify 
specific areas. The same set is manually applied to each model to pair it with the 
template. The software then wraps the mesh around the target model.

3. Exclude Regions
Incomplete sections of the processed model are excluded from the wrap 
process. These differ per model, but are mainly the hands, elbows, feet and 
inner legs.

4. Project & Smoothen
The last actions more accurately project the base mesh around the target 
model. The model is also smoothened slightly to compensate for inaccuracies.

5. Transform & Save
The model is scaled correctly and saved as an OBJ file.

3.

5.

4.

1.

2.

In Detail
Landmarks
Most landmarks are applied at anatomical reference points such as joints or limb 
ends. The middle of the chin, mouth and nose are common landmarks, but the 
cyclist models specifically lack data there because they are 3D scanned in two 
halves. The goal is to select a minimum amount of landmarks for the best result, 
because landmarks are applied to each model manually. A total of 47 markers 
are applied to correspond the cyclists (Figure 3.17). The landmarks of each 
model are saved and reused for bias removal iterations.

Excluded Polygons
Polygons are excluded if a model lacks data in specific areas. The processed 
cyclist models lack information near the hands, elbows, feet and inner legs. 
A polygon selection is made manually for each individual scan to exclude the 
regions. Landmarks are removed if they touch any selected polygons. The R3DS 
Wrap3 software makes a standardization for the excluded polygons instead of 
attempting to wrap directly to the model (Figure 3.18). Excluded polygons of 
each model are saved and reused for bias removal iterations.

Landmarks

Figure 3.17: Keijser, L. (2022). [Visualization of landmarks applied to template and 
processed model].

Figure 3.18: Keijser, L. (2022). [Visualization of excluded polygons selected on a 
processed model].

Figure 3.16: Keijser, L. (2022). [Infographic of workflow in R3DS]. 
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Base Mesh Template
A base mesh template is required to correspond 
the first set of models before performing a 
reference bias iteration (Guigmond et al., 2000). 
The R3DS Wrap3 library offers a template of a 
male in standing position, which is manipulated 
in Blender (Blender Foundation, 2018) to mimic 
a cycling position. The arms and legs are 
manipulated slightly and the hands are shaped 
like fists in the same way a cyclist holds the 
handlebars.

An accurate base mesh template produces 
accurate results (Figure 3.19). The base mesh is 
converted from quadrilateral to triangle polygons. 
The mesh is also converted from adaptive to 
uniform polygons, as the model requires the same 
level of detail everywhere. The total count is 
increased to 50.000 vertices to improve resolution 
of the model. The ACVDQ program (Valette, n.d.) 
is used to perform the simplification of the mesh.

The corresponding process and base mesh 
template are designed and performed in 
collaboration with Lies Keijser and Toon Huysmans.

Manipulation of the base mesh template is 
illustrated on the following page. It is performed to 
correspond the template to the 3D scan models 
more accurately. It influences the realism of the 
base mesh due to the deformations, however. 
Any deformation is kept to a minimum, but some 
elements of the model still unnaturally deform near 
the shoulder, elbow and hip joints. Vertices are 
distributed differently in these sections and that 
translates to the Generic Model. The base mesh 
may be adjusted to overcome such challenges, but 
that is not performed in this research.

TemplateMesh_BaseCyclist_R_tri_50k_uniform_EXTRASMOOTH

Figure 3.19: The base mesh in original resolution (left) and final resolution (right) in road pose. 

TemplateMesh_BaseCyclist_R_tri_50k_uniform

Figure 3.26: Use different view angles to verify the 
body position.

Figure 3.20: The wrap template is imported in 
Blender and an artificial body skeleton is applied.

Figure 3.21: The rig allows you to manipulate joints 
and the overall body position.

Figure 3.22: A side view image of the Dumoulin 
Mannequin is used as an underlay for the pose.

Figure 3.23: By correctly placing and scaling the 
underlay, it is easily traced.

Figure 3.24: All limbs are carefully manipulated.

Figure 3.25: The body position can be recreated 
quite accurately with this method.

Method
The model is reshaped into a cycling 
pose to create a more accurate 
template for this project. The open-
source software Blender is used to 
manipulate the template model.
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Figure 3.27: The first version of the base mesh 
template.

Figure 3.28: The second version of the base mesh 
template.

Figure 3.29: The third version of the base mesh 
template.

Development
Pose Version 1
The first base mesh is a template from the Wrap 
library manipulated in Blender to the pose of the 
Dumoulin Mannequin (Figure 3.27). The body is 
manipulated into a close representation of the 
pose with the fingers spread out.

Pose Version 2
In the second version of the base mesh template, 
the model’s hands are shaped like fists (Figure 
3.28) instead of the fingers pointing outward. This 
helps to correspond the hands.

Pose Version 3
In the third version of the base mesh, the model 
is placed in a more relaxed position (Figure 3.29). 
Deformation occurrs near joints where the model 
is heavily manipulated, causing folds in the mesh. 
The third version avoids the deformation, while still 
approaching the cycling pose effectively. A model 
specific for the road pose is created too.

Figure 3.31: Keijser, L. (2022). [Visualization of a 250K Fast Fusion, 250K Smooth 
Fusion and a 50K Smooth Fusion model.

Figure 3.30: Keijser, L. (2022). [Visualization of a regular and a smoothened base 
mesh template].

Smoothing
A standard base mesh is defined by its polygonal structure, but the human 
body has a smooth surface. The base mesh must be smoothened to realistically 
correspond the models. The Sculpt Tool from the Meshmixer software 
(Autodesk Meshmixer, 2020) is used to achieve the desired result (Figure 3.30). 
The Inflate and BubbleSmooth brushes smoothen facets facing outward and 
inward respectively . Any smoothing to the model must be performed carefully, 
as the brushes can manipulate the model heavily. Minimal manipulation is 
preferred to retain detail of the model.

Resolution
The resolution of the base mesh template from the R3DS Wrap library does 
not suffice for the Generic Model. It is an adaptive quadrilateral mesh with more 
details near the hands, face and feet. The resolution is too low, so individual 
facets are clearly visible. Base mesh variations are created by Toon Huysmans 
find the optimal model.

The mesh is changed from quadrilateral to triangle polygons to follow the 
organic shapes of the model. Uniform meshes are created to achieve an equal 
amount of detail over the entire model. Three different resolutions are made 
and compared: 50K, 100K and 250K polygons. Comparisons show that higher 
resolutions emphasize inaccuracies in the processed models (Figure 3.31). The 
50K mesh is selected as it causes least deformations is of sufficient quality for 
the Generic Model.
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3.2 Generic Model: Method

3.2.4 Average
An average is calculated in the ParaView software 
(Ayachit, 2015) when all the individual models are 
corresponded. The models are loaded into the 
software which recognizes their identical base 
meshes. The average model is generated and 
visualized (Figure 3.32).

AlignAndComputeAverage
Custom filters by Toon Huysmans are imported to 
compute the mean of the models. This commands 
aligns the individual models and calculates the 
mean average. A weighted average can be 
generated to change the importance of individual 
data, but that is out of the scope of this research. 
This may be applied to match the anthropometric 
data of a professional cyclist population.

LoopSubDivision
“The Loop Subdivision filter increases the 
granularity of a polygonal mesh. It works by 
dividing each triangle in the input into four new 
triangles.” (Ayachit, 2015). This command is used 
to increase the detail and smoothness of the final 
model, as this is a key requirement of the Generic 
Model. Individual facets become less apparent.

SimpleClean
“The Clean filter can merge duplicate points, 
remove unused points, and transform degenerate 
cells into their appropriate forms.” (Ayachit, 2015). 
Any unwanted elements are removed by this 
command and the Generic Model is ready to 
export.

GenericModelTT-Correction

Figure 3.32: The Generic Model of 10 riders in time trial pose.

Figure 3.33: First version of the Generic Model in 
road and time trial.

GenericModel_V2_TT

GenericModel_V3_TT

Figure 3.34: Second version of the Generic Model in 
time trial pose.

Figure 3.35: Third version of the Generic Model in 
time trial pose.

Generic Model V1
The first version of the Generic Model is generated 
using the male body base mesh from the R3DS 
Wrap3 library manipulated into cycling position. 
An average of four riders is generated in road and 
time trial pose (Figure 3.33). The low resolution, 
quadrilateral base mesh is clearly identifiable. The 
model in road pose has a more realistic face than 
the model in time trial pose, despite the individual 
3D scans being of lower quality. Some of the 3D 
scans are processed again to achieve this result. 
The deformations in the face of the other model 
are caused by the arms blocking the face during 
3D scanning. Both models show fabric or skin folds 
near the armpits and crotch where the base mesh 
template is heavily manipulated.

Generic Model V2
The second version of the Generic Model is 
generated using a high resolution, uniform, triangle 
base mesh An average of ten riders is generated 
in time trial pose (Figure 3.34). Improving the 
base mesh resolution highlights small errors in the 
processed models and they are processed again 
increase the quality. Due to the time consuming 
nature of the task, the time trial pose of the 
Generic Model is given priority over the road pose. 
The high resolution mesh is an improvement to the 
model and individual facets become less apparent. 
The face, hands and feet have an identical level of 
detail compared to the rest of the body. The base 
mesh template’s pose is relaxed to avoid the fabric 
and skin folds near the armpits and crotch.

Generic Model V3
The third version of the Generic Model is 
generated using a smoothened version of the 
original base mesh. An average of ten riders is 
generated again (Figure 3.35). The smoothened 
base mesh creates a more realistic result 
overall. This result is also achieved by applying 
the LoopSubDivision and SimpleClean filters in 
Paraview. The individual models are processed 
once more to remove elements of the bicycle 
such as the elbow rests. Smooth Fusion settings 
in Artec are applied to remove noise from the 
models and to contribute to the smoothened 
effect. This is the final Generic Model of this project 
and the recommendation is to apply the identical 
modelling steps to the model in road pose.
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Means 
compared

Team DSM 
male road 
cyclist dataset

London 2012 
Olympics male 
road cyclist 
database

Age (years) 19.7 28.4

Weight (kg) 71.0 74.1

Length (cm) 182.0 178.0

Weight (kg)
Team DSM 
male road 
cyclist dataset

London 2012 
Olympics male 
road cyclist 
database

Minimum 63 55

Maximum 79 86

Mean 70.5 72

Median 71 74.1

Height (cm)
Team DSM 
male road 
cyclist dataset

London 2012 
Olympics male 
road cyclist 
database

Minimum 172 165

Maximum 190 199

Mean 179.4 178

Median 182.0 178.0

Figure 3.37: Minimum, maximum, median and mean 
weight compared.

Figure 3.38: Minimum, maximum, median and mean 
height compared.

Figure 3.36: Mean values of Team DSM dataset 
compared to London 2012 Olympics database.

Data Analysis
Mean Values
The dataset acquired in this research is compared 
to demographic data of male, road cyclists 
who competed at the London 2012 Olympic 
Games (Wood, 2015). The Generic Model must 
represent the professional cycling population 
and this database is the most relevant, readily 
available reference point. Comparing mean age, 
height and weight (Figure 3.36), mean body size 
appears similar while mean age greatly differs. 
The difference is explainable as participants in 
this research are young riders from Team DSM’s 
development team, instead of the older WorldTour 
team.

Weight Values
Comparing weight for minimum, maximum, median 
and mean values (Figure 3.37), characteristics of 
the dataset become apparent. First, the mean 
weight differs by 3.1 kg. Second, the dataset range 
is noticeably limited compared to the database. 
The database shows a positively skewed 
distribution.

Height Values
Comparing height for minimum, maximum, median 
and mean values (Figure 3.38), even more limits 
of the dataset become apparent. First, the mean 
length differs by 4.0 cm. Second, the dataset 
range is limited in terms of length, similar to the 
weight. The database shows a positively skewed 
distribution.

Weighted Average
As more riders are added to the Generic 
Model, it becomes a better representation of 
the professional cycling population. However, 
the data will always have limits. A weighted 
average may be generated to make the model 
more representative. Individual riders each 
receive a weight to optimize the Generic Model. 
Optimalization pa-rameters may be an identical 
mean and median. The database is not completely 
representative of the population however and that 
is a limitation of this model.

4. Personalized Mannequin
4.1 Design

4.2 Method

4.3 Development

4.4 Design Features

4.5 Validation
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The second goal of this research is to design a 
personalized cyclist mannequin for aerodynamics 
researchers. The Personalized Mannequin 
designed in this project is called Rupert. Rupert is a 
personalized cycling mannequin for aerodynamics 
testing in the wind tunnel. The mannequin is life-
size and can be modelled after any 3D scanned 
cyclist. Rupert’s pose is static, able to precisely 
repeat position between tests. Any cycling gear 
can be applied to the mannequin, because of its 
smooth surface and clever segmentation. The 
mannequin has a minimal amount of separate limbs 
which attach & detach with a single motion. Rupert 
can be mounted to the rider’s bicycle without 
any modifications to it. Its design ensures a great 
moisture, temperature and impact resistance.

4. Personalized Mannequin

4.1 Design
Materials & Production
CNC milled, high density polyurethane foam.
Treated with sealant and a light sanding.
Painted matte black for low light reflectivity.

Interaction Segmentation
Segmented legs, arms & hands.
Bevelled edges to slide suit over.
Recessed interface slots.

3D Digital Model
High-drag leg position, hands separated.
Static pose, 3D scanned on personal bicycle.
Uniform, smoothened surface.

Attachment Interfaces
Magnetic, form-fitting interfaces.
Colour-coded for instant recognition.
Identical for each mannequin.

The Mannequin
In Six Questions

Who?
Aerodynamics expert Harm Ubbens 
and colleagues at cycling Team DSM.

What?
Using a cyclist mannequin for 
aerodynamics tests to compare gear 
for both riders and bicycles, such as 
helmets, suits and wheels.

Where?
In a wind tunnel, such as the Open Jet 
Facility at TU Delft.

When?
Commonly 3-4 sessions a year of 1-3 
days at a time.

Why?
First, a mannequin is a constant factor 
in measurements and eliminates the 
variable posture of a human subject.
Second, a mannequin eliminates the 
logistical and physical limitations a 
human subject involves.

How?
The human subject is replaced by the 
cyclist mannequin on the bicycle during 
aerodynamics tests.

Bicycle Mounts
Wears cycling shoes to clip into pedals.
Rests most of its weight on a regular saddle.
Flexible hand interface mounts to handlebar.
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User Interaction
Rupert is dressed, attached and mounted for 
every test performed in the wind tunnel. A 
minimum amount of intuitive actions make the 
process fluent. The interactions between user 
and mannequin are visualized in Figure 4.1 and 
individually described below.

1. Attach hands to handlebar.
Rupert’s flexible hands are shaped around the 
handlebar and remain attached throughout the 
entire test session. The arms always attach to the 
same point for accurate repeatability.

2. Apply socks & shoes to legs.
The socks and shoes are applied to the foot so 
Rupert can mount to the pedals. They remain 
applied throughout the session if possible.

3. Attach shoes to pedals.
The shoes are attached to the pedals using cycling 
cleats. Rupert’s legs are placed on the ground 
when the torso is not attached.

4. Apply suit to torso (roll up sleeves).
The cycling suit is applied to Rupert’s torso, 
starting with the legs. The sleeves are rolled up so 
the attachment interfaces become exposed.

5. Attach torso to limbs.
Rupert is seated on the saddle and attached to the 
arms for stability. The legs are attached last. Rupert 
is now fully mounted to the bicycle. Figure 4.1: Segmentation and user interaction of the mannequin in road pose.

Figure 4.8: The helmet is applied to complete 
dressing the mannequin.

Figure 4.9: The mannequin is adjusted for precise 
positioning.

Figure 4.2: The cycling suit is applied to the legs 
first and rolled up.

Figure 4.3: The cycling suit is pulled over the 
shoulders and arms.

Figure 4.4: The legs are attached and the cycling 
suit is rolled down.

Figure 4.5: The sleeves of the cycling suit cover the 
seam between the limbs.

Figure 4.6: The assembled mannequin is placed on 
the bicycle in a stand.

Figure 4.7: The arms are placed on the elbow rests 
and the hands on the bar-ends.

Interaction Scenario Rupert #1
Harm Ubbens & Wouter Terra dress, 
assemble and mount Rupert to a time 
trial bicycle. All intended interactions 
are described here.
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A cycling mannequin is an Ultra-Personalized 
Product, requiring an Automated Workflow as it is 
different for every customer. Based on the Centre 
of Design for Advanced Manufacturing (CDAM, 
n.d.) approach, the workflow is divided into four 
sections: Digitalization, Design Automation, Digital 
Fabrication & Human-Robot Coproduction (Figure 
4.10). This describes all steps involved in the 
process from 3D scanning a subject to assembling 
the mannequin. An interview with Sander Minnoye 
about Advanced Manufacturing is the foundation 
of the workflow (Appendix 3.1).

Digitalization
3D Scan a cyclist and process the model to edit in 
CAD software. It is identical to the Generic Model 
approach and not discussed again in this chapter.

Design Automation
Automatically apply design features to the model 
by using parametrically defined requirements.

Digital Fabrication
Precisely fabricate the model by using additive and 
subtractive manufacturing.

Production
Complete the product by finishing fabricated 
parts and assembling the mannequin. Only manual 
production is involved in this project.

4. Personalized Mannequin

4.2 Method

Figure 4.10: CDAM. (n.d.). [Schematic of Advanced Manufacturing approach].

4.2 Personalized Mannequin: Method

4.2.1 Design Automation
All design features of the Personalized 
Mannequin are parametrically defined so they can 
automatically be applied to any model with the 
same correspondence. The complete process is 
performed manually in Blender once to fabricate 
the full-scale mannequin. Part of the process is 
coded in a Grasshopper script (Figure 4.11) to 
segment the hands. DINED User Objects allows 
selection of a specific vertex to apply design 
features to. The feature is automatically applied to 
the identical vertex of any corresponded model.

Not all design features are included in the script for 
this project. A feature tree describes the modelling 
steps chronologically. The script automatically 
applies all design features to any cyclist model, 
automating the digital design process of the 
Personalized Mannequin.

Figure 4.11: Automatically applying a plane cut at the wrists of the model in Grasshopper.
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Interaction Segmentation
Segment Arms
The arms are segmented identically to the 
hands, but on a different vertex in another plane 
orientation. It is performed by positioning a 
horizontal plane on the desired vertex to split the 
limbs (Figure 4.12).

Select vertex at 55 mm arm protrusion.
 • Vertex Picker > Select Vertex

Input vertex number.
 • Params > Input > Panel

Create horizontal plane.
 • Vector > Plane > XY Plane

Apply plane cut.
 • Mesh > Util > Mesh Split Plane

Segment Legs
The legs are segmented differently, because the 
cutting plane is oriented in relation to the model. 
It is performed by drawing a line through the 
middle of the upper leg. A plane is positioned 
perpendicular to the line in its centre to split the 
limbs.

Select three vertices in line at knee and hip.
 • Vertex Picker > Select Vertex

Input vertex number.
 • Params > Input > Panel

Draw circle through knee and hip using selected 
vertices.

 • Curve > Primitive > Circle 3Pt

Draw line from centre to centre.
 • Curve > Primitive > Line

Select line midpoint.
 • Curve > Analysis > Curve Middle

Create plane perpendicular to line through 
midpoint.

 • Vector > Plane > Plane Normal

Apply plane cut.
 • Mesh > Util > Mesh Split Plane

Repeat for other leg.

Bevel Edges
The edges are bevelled by applying the feature to 
the created segment faces (Figure 4.13).

Select segment faces.
 • Intersect > Mathematical > Mesh | Plane

Apply bevel.
 • Weaverbird > Transform > Bevel Edges

Interface Slots
The interface slots are all applied identically, but 
on a different vertex. The interface slot model 
is loaded and positioned on the segment face 
centre. The model is oriented perpendicular to the 
face and subtracted from the limb segment (Figure 
4.14).

Select vertex at segment face centre.
 • Vertex Picker > Select Vertex

Input vertex number.
 • Params > Input > Panel

Load interface slot model as STL.
 • Params > Primitive > File Path

Convert STL to mesh.
 • DINED > STL Reader

Orient interface slot perpendicular to segment 
plane.

 • Transform > Euclidian > Orient

Position interface slot at vertex.
 • Transform > Euclidian > Move

Cut interface slot from limb segment.
 • Intersect > Util > Mesh Difference

Repeat for other limb segments.

Figure 4.12: Segment the limbs by splitting the 
model with planes.

Figure 4.13: Bevel edges of the segment faces on 
both sides of the cut.

Figure 4.14: Cut the interface slots from all limb 
segments.
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The design model is edited once more to begin 
Digital Fabrication. Requirements depend on 
the fabrication method, but CNC milling involves 
segmentation based on machine size, amount of 
axes, material dimensions and material efficiency. 
However, such actions are commonly performed 
by the manufacturing party. The production 
model is loaded into CNC milling software such 
as Fusion 360 to select fabrication settings. The 
polyurethane foam is milled and untreated limb 
segments form the result of Digital Fabrication.

The Digital Fabrication process is performed 
multiple times in this project. The process of 
CNC milling a foot segment in is described in this 
chapter (Figure 4.15). The following settings in 
DeskProto are used to digitally fabricate it.

Material:    Polyurethane foam 80 kg/m3
Machine:    FLDM1325 3-axis CNC mill
End Mill Cutter: Ø 10 mm, 160 mm length
Detail:    1.1 mm
Layer height:  15 mm
Time:     4-5 hours

4.2 Personalized Mannequin: Method

4.2.2 Digital Fabrication

Figure 4.15: An untreated,, CNC milled foot prototype with box supports.
Figure 4.22: The foot is now milled from the 
bottom side.

Figure 4.23: Result of the foot after CNC milling is 
completed.

Figure 4.16: A box support is added to the foot 
segment in SolidWorks.

Figure 4.17: Milling paths and layers are selected 
and adjusted in DeskProto.

Figure 4.18: The first layer is CNC milled and frame 
contours become visible.

Figure 4.19: Milling is complete for the top side of 
the foot.

Figure 4.20: Double-sided tape is applied to the 
other side of the object.

Figure 4.21: The object is placed in the same 
position on the milling board.

CNC Milling Process
CNC Milling is performed with the help 
of expert Don van Eeden at the Model 
Making Machine Lab of the TU Delft. A 
support box is added to the limb in the 
example to flip it halfway the process.
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Lastly, the Personalized Mannequin is produced 
by joining the limb segments, finishing the limbs 
and assembling the product. Recognizable limbs 
form when the segments are joined and finished. 
Polyurethane rigid foam has excellent treatment 
properties, but requires only little treatment after 
fabrication. The limbs receive a protective coating 
before assembly with stock attachment interfaces 
and other hardware. A completely assembled, 
Personalized Mannequin is the result of the 
Production step.

The Production process is performed once on 
a CNC milled, polyurethane limb in this project 
(Figure 4.24). The foot segment is used to test 
production steps to achieve the right finish. After 
all, it still has a rough surface and is connected to a 
support frame.

4.2 Personalized Mannequin: Method

4.2.3 Production

Figure 4.24: A partially sanded and coated, CNC milled foot prototype.

Figure 4.26: The resulting foam tiles after coating. Figure 4.27: Half of the foot is sanded and coated.Figure 4.25: The resulting foam tiles after sanding 
with P240, P120 & P80 (left to right).

Sanding
Sanding paper is applied to prepare the limb 
for painting. The papers are wrapped around a 
sanding block to create an even surface. Three 
types of sanding paper are used here (Figure 
4.25).

 • P240 grit (medium)
 • P120 grit (fine)
 • P80 grit (very fine)

Coating
Rattle can spray paint is used on the limb after 
sanding. Two layers of coating are applied to the 
polyurethane foam tiles. Three types of spray 
paint are used here (Figure 4.26).

 • OK: Matte black
 • Spray.Bike: Matte green (self-priming)
 • Spectrum: Glossy black

Finish
Half of the foot is untreated, half of the foot is 
sanded with P240 & P80 and coated thrice with 
OK matte black paint. This allows comparison 
between each halve (Figure 4.27).

All three sanding papers work effectively on the 
polyurethane foam. The surface finish is good 
and large inaccuracies are easy to smoothen. The 
foam remains grainy and lots of dust is created 
during sanding. A better surface finish would be 
preferable at this stage for a quality coating.

All three spray paints bond well to the 
polyurethane foam and form a smooth coating. 
The foam is hardly grainy and little dust appears. 
The higher-end Spray.Bike paint creates the most 
solid, protective layer. While the results only 
marginally differ, the glossy paint leaves a slight 
sparkle. The others create a more preferable, 
matte surface colour. A hard, smooth, top coating 
would be even better.

Sanding the foot is very effective. Any milling 
marks are smoothened, but so are essential 
shape details. Sanding without a block creates 
uneven pressure and can leave marks on the 
surface. Sometimes even large scratches appear. 
Polyurethane foam of 80 kg/m3 density is fragile 
and damages easily. A higher density foam would 
be preferable for the mannequin limbs.
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Several methods are used to 
structure the creative process in 
this project. A Pressure Cooker of 
the creative process is performed 
early in the project to identify 
opportunities and to select design 
methods. Results of the Pressure 
Cooker are included in Appendix 
4. This page explains which design 
methods are used and how they 
contribute to the project.

4. Personalized Mannequin

4.3 Development

List of Requirements
Resulting from the Product Life 
Cycle, a List of Requirements is 
defined. Unlike the name suggests, 
the list contains both requirements 
and desires. Requirements are 
used to validate the mannequin’s 
functionality while desires are used 
to make design decisions.

Product Life Cycle
With the Dumoulin Mannequin 
as a project predecessor, the 
Personalized Mannequin’s Life 
Cycle is well defined. The list of 
product interactions is detailed and 
complete to serve as a baseline for 
the product’s design.

Function Analysis
Key processes from the Product 
Life Cycle are also used to 
conduct a Function Analysis. 
Selecting and clustering essential 
product interactions serves as 
the foundation for structured 
ideation. This ensures that all design 
challenges in the project are tackled.

How-Tos
With product functions clearly 
defined in the Function Analysis, 
How-Tos generate countless 
solutions to each one. All design 
challenges are tackled as they are 
isolated and generated ideas may 
return later in the project. 

Analysis Ideation

Concept Design
Designing an integrated concept 
is the next step when all idea 
combinations are made. Design 
Drawing is used to visualize and 
specify the integrated features of a 
concept. Interactions with the user 
and context are essential to include.

Morphological Chart
By structuring and combining 
solutions generated following the 
How-Tos, a Morphological Chart 
generates varying concepts. Digital 
Fabrication methods are used 
as the core of the concept and 
appropriate solutions are combined 
in turn.

Harris Profile
By ranking and clustering desires 
from the List of Requirements, a 
Harris Profile rates concept quality. 
Ratings are quite easily applied as 
concepts are only rated relative to 
one another. A concept is selected 
in consultation with the client.

Concept Redesign
The selected concept is redesigned 
as new insights arise. As the 
concept is being developed, the 
process becomes iterative and the 
design gradually evolves. This is 
how a concept becomes a product.

Conceptualization Design
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Product Life Cycle
“A schematic diagram of the activities that a product encounters during its life 
cycle.” (Van Boeijen et al, 2020).

4.3 Personalized Mannequin: Development

4.3.1 Product Life Cycle
Assemble

Dress

Mount

Test

Use unintended

3.3

3.4

3.5

3.6

3.7

Assemble in road position
Assemble in time trial position
Re-assemble in between tests

Dress in cycling suit
Dress in cycling socks
Dress in cycling shoes
Dress in cycling helmet
Dress in cycling glasses
Change outfit in between tests

Mount to road handlebar
Mount to time trial handlebar
Mount to bicycle saddle
Mount to bicycle pedals
Re-mount in between tests
Mount to different bicycle geometry

Test in wind tunnel

Test with Particle Image Velocimetry

Drop on the floor

3.3.1
3.3.2
3.3.3

3.4.1
3.4.2
3.4.3
3.4.4
3.4.5
3.4.6

3.5.1
3.5.2
3.5.3
3.5.4
3.5.5
3.5.6

3.6.1

3.6.2

3.7.1

# Process # Sub-processList of Requirements
“States the important characteristics that a design must have in order to be 
successful.” (Van Boeijen et al, 2020).

The mannequin can be assembled by a single adult.
The mannequin can change torso & arm position.
The mannequin’s limbs are quickly (dis)assembled.

The mannequin has detachable arms & legs.
The mannequin has bare feet & lower legs.
The mannequin has smoothened feet.
The mannequin has a bald head.
The mannequin has facial features.
The mannequin has a smooth surface.

The mannequin can hold parallel Ø 35 mm Road bars with its hands.
The mannequin can hold parallel Ø 25 mm TT bars with separate hands.
The mannequin has a 165 mm open area between the legs.
The mannequin can twist its legs.
The mannequin is quickly (un)mounted.
The mannequin has limited joint flexibility.
The mannequin’s pose is accurately adjustable.

The mannequin’s shape represents its subject.
The mannequin’s shape is accurately realistic.
The mannequin’s seams are unobtrusive.
The mannequin is rigid on the bicycle.
The mannequin is rigid on the bicycle while wobbling sideways.
The mannequin’s pose is accurately repeatable.
The mannequin has a matte, black colour finish.
The mannequin is water resistant up to IPX4.

The mannequin is impact resistant up to 1.5m.

3.3.1.1
3.3.2.1
3.3.3.1

3.4.1.1
3.4.2.1
3.4.3.1
3.4.4.1
3.4.5.1
3.4.6.1

3.5.1.1
3.5.2.1
3.5.3.1
3.5.4.1
3.5.5.1
3.5.6.1
3.5.6.2

3.6.1.1
3.6.1.2
3.6.1.3
3.6.1.4
3.6.1.5
3.6.1.6
3.6.2.1
3.6.2.2

3.7.1.1

Figure 4.28: List of Requirements from the Use phase of the Product Life Cycle.

# Requirement

Analysis ConceptualizationIdeation

The goal of this method is to create a list of demands that can validate concepts 
and to create a list of desires that can be used for selection. The List of 
Requirements is extensive as it is based on user interactions from the Product 
Life Cycle. This ensures that all interactions with the product result in a relevant 
requirement or desire. The Originate & Distribute phase include requirements 
for the 3D scan subject. Not all processes result in a requirement, though some 
result in multiple. Arguments are used to substantiate the requirements.

Requirements are used to verify the mannequin’s functionality while desires 
are used to make design decisions. They are used to design relevant concepts 
and to make a substantiated selection. They return during validation of the 
mannequin to evaluate the final design. Requirements and desires based on part 
of the Use phase are shown in Figure 4.28. Desires are highlighted in red. For the 
full List of Requirements and Product Life Cycle, refer to Appendix 5.

Key requirements
 • The mannequin is rigid on the bicycle.
 • The mannequin’s shape represents its subject.
 • The mannequin has detachable arms & legs.
 • The mannequin has limited joint flexibility.
 • The mannequin can change torso & arm position.

The goal of the Product Life Cycle is to list and order all interactions with the 
mannequin and user. The Product Life Cycle diagram is divided into three 
columns: phase, process and sub-process. The standard phases included are the 
Originate, Distribute, Use and Discard phase. All processes and sub-processes 
are clustered for each phase and describe the complete Product Life Cycle. The 
diagram creates an overview of interactions and helps to set requirements and 
priorities with following methods. The Use phase of the Product Life Cycle is 
shown in Figure 4.28.

Originate. Processes in the Originate phase are based on the workflows of the 
Generic Model and Personalized Mannequin. This phase starts by selecting a 
subject for the mannequin and ends with packaging the product.

Distribute. The Distribute phase contains processes relevant to the data security 
of the customer and the delivery of the mannequin. This phase is least important 
in this project.

Use. The Use phase is based on the interaction scenario with the Dumoulin 
Mannequin. It lists the mannequin’s most important interactions such as 
assembling, dressing, mounting and testing. Unintended use is also included.

Discard. The Discard phase covers the end-of-life of the mannequin. It covers 
possibilities of disassembling, reusing, recycling and discarding of product parts. 
It has relatively low priority.

Analysis ConceptualizationIdeation
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“A method for analysing and developing the 
function structure of an existing product or new 
product concept.” (Van Boeijen et al, 2020).

4.3 Personalized Mannequin: Development

4.3.2 Function Analysis

Freedom of 
movement

Repeatable 
fixture

None

Connection 
mechanism

Limb 
segmentation

Connection 
mechanism

Connection 
mechanism

Foot-shoe 
shape

Neck 
segmentation

3.1 Mount bottom 
to saddle

2.1 Connect 
arms to torso

1.1 Apply suit 
to torso

1.2 Apply 
shoes to feet

1.3 Apply 
helmet to head

2.2 Connect 
legs to torso

2.3 Connect 
head to torso

3.2 Mount 
hands to bar

3.3 Mount feet 
to pedals

3 (Un)mount to 
bicycle

2 (Dis)connect 
body parts

1 Apply cycling 
gear

Hold cycling 
position on 
bicycle

Figure 4.29: Function Analysis of the mannequin based on the ‘Use’ phase of the Product Life Cycle.

ChallengeSub-functionsMain functionsKey function “How-Tos are problem statements written in the 
form of questions that support brainstorming and 
idea generation.” (Van Boeijen et al, 2020).

4.3 Personalized Mannequin: Development

4.3.3 How-Tos

Figure 4.30: Design drawings of How-To 
connect head to torso & mount feet to pedals.

Analysis ConceptualizationIdeation

The goal of the Function Analysis is to isolate 
product functions and solve each design challenge 
individually. The Function Analysis is based on 
Product Life Cycle sub-processes Assemble, 
Dress and Mount (Figure 4.29). The main functions 
split into sub-functions that are used to generate 
design challenges. The sub-functions logically 
follow the analysis of where the mannequin 
connects to the bike, segments its body parts and 
wears its clothes. Sub-functions are used as the 
basis for idea generation in this project. The design 
challenges are used to eliminate, combine or to 
tackle each sub-function differently. Sub-functions 
2.1, 2.2, and 2.3 pose the same challenge and 
are effectively combined during idea generation. 
Sub-function 3.1 poses no challenge at all as the 
Dumoulin Mannequin effectively tackled it already.

The goal of the How-Tos is to generate lots of 
ideas based on product function design challenges. 
How-Tos are generated based on challenges 
found in the Function Analysis. Design Drawing 
techniques are used to visualize ideas, as that 
is important with a physical product such as the 
Personalized Mannequin. Underlays are used to 
quickly and repeatedly draw the complex body 
shapes. Nine sub-fuctions are identified by the 
Function Analysis. Design challenges for sub-
functions 2.1, 2.2 and 2.3 are combined and sub-
function 3.1 is eliminated. That brings the number 
down to six sub-functions and the following How-
Tos are performed:

How To …
 • Apply suit to torso   (Figure 4.32)
 • Apply shoes to feet  (Figure 4.30)
 • Apply helmet to head (Figure 4.30)
 • Connect limbs  (Figure 4.31)
 • Mount hands to handlebar (Figure 4.31)
 • Mount feet to pedals (Figure 4.31)

Analysis ConceptualizationIdeation



Figure 4.31: Design drawings of the other How-Tos. Figure 4.32: Design drawings of random ideation.
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“Helps designers generate solutions in an analytical 
and systematic way.” (Van Boeijen et al, 2020).

4.3 Personalized Mannequin: Development

4.3.4 Morphological Chart

Spring tension

Hinge

Press fit

Threaded

Clamp

Magnetic

Form fit

Binding material

Figure 4.33: Clusters of similar ideas to combine.

3.1 Mount bottom to 
saddle

2.1 Connect arms to 
torso

1.1 Apply suit to torso

1.2 Apply shoes to feet

1.3 Apply helmet to 
head

2.2 Connect legs to 
torso

2.3 Connect head to 
torso

3.2 Mount hands to bar

3.3 Mount feet to pedals

Anatomical Freely moving Practical Shape optimized Efficient

Spring loaded Flexible shape Shape negative Front-end fit Simplified shape Twisting sections Natural shape

Mid-neck Jaw-neck Shoulder-neck

Form-fit Binding material Spring tension Hinge Press fit Threaded Clamp Magnetic

Form-fit Binding material Spring tension Hinge Press fit Threaded Clamp Magnetic

Form-fit Binding material Spring tension Hinge Press fit Threaded Clamp Magnetic

Thumb clamp Knuckle hinge Open hole Rotating wrist Spring loaded Wrist attachment Magnetic fingers Closed hole

Knee-ankle joint Flexible lower leg Ankle attachment Flexible knee Flexible hip

Open shape

Figure 4.34: Morphological chart with solutions for each sub-function of the mannequin.

Concept 1Concept 2 Concept 3

Analysis ConceptualizationIdeation

The goal of the Morphological Chart is to 
combine solutions to individual design challenges 
as a way to generate concepts. All individual 
ideas generated using How-Tos are placed in 
their respective positions in the Morphological 
Chart. Irrelevant ideas are removed and similar 
or duplicate ideas are clustered (Figure 4.33). 
Solutions to functions 2.1, 2.2 and 2.3 are identical 
as these share the same requirements. Only 
one solution is presented for function 3.1 as it 
proved successful for the Dumoulin Mannequin. 
Countless idea combinations can be made 
using the Morphological Chart. Three digital 
fabrication methods are used as the basis for idea 
combinations here. The methods are, in order: CNC 
milling & 3D printing combined (1), mainly 3D printed 
(2) and mainly CNC milled (3). The fabrications 
methods are further described on the following 
pages. The idea combinations are visualized in 
the Morphological Chart (Figure 4.34). Identical 
ideas or idea combinations are selected for some 
product functions. The idea combinations are more 
structurally presented on the following pages for 
clarification purposes.
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4.3 Personalized Mannequin: Development

4.3.5 Concepts
The concepts generated are the result of a Morphological Chart, based on 
different digital fabrication methods. The following concepts are generated:

 • Concept 1: Perses  (Mixed fabrication)
 • Concept 2: Astraeus (3D printed)
 • Concept 3: Pallas  (CNC milled)

Design solutions selected in the Morphological Chart are chosen specifically for 
the relevant fabrication method. A distinction is made between subtractive and 
additive manufacturing, as well as the specific method applied. The goal is to 
explore opportunities where production and design meet.

Subtractive Manufacturing
CNC Milling
“CNC machining uses computer software to control machine tools that cut 
complex 2D and 3D shapes out of blocks of material. CNC machining is very fast, 
accurate, and repeatable, capable of achieving precise tolerances.” (Figure 4.35).

“Rigid and flexible polyurethane foams are commonly used to make production 
parts in nearly every industry – including aerospace, automotive, recreation, 
consumer, and medical markets.” (General Plastics, n.d.).

Figure 4.36: FormLabs. (n.d.). [Infographic of plastics 3D printing technologies].Figure 4.35: General Plastics. (n.d.). [Photograph of CNC milled surfaces].

Additive Manufacturing
Using knowledge from FormLabs, the three most 
established plastic 3D printing processes today are 
studied more closely (Figure 4.36).

Stereolithography (SLA)
“SLA is a great option for highly detailed 
prototypes requiring tight tolerances and smooth 
surfaces, such as molds, patterns, and functional 
parts (Figure 4.38). SLA is widely used in a range 
of industries from engineering and product design 
to manufacturing, dentistry, jewelry, model making, 
and education.” (FormLabs, n.d.).

Selective Laser Sintering (SLS)
“The combination of low cost per part, high 
productivity, and established materials make SLS 
a popular choice among engineers for functional 
prototyping, and a cost-effective alternative 
to injection molding for limited-run or bridge 
manufacturing (Figure 4.39).” (FormLabs, n.d.).

Figure 4.37: FormLabs. (n.d.). [Photograph of FDM 
parts showing layer lines and inaccuracies in the 
surface].

Fused Deposition Modelling (FDM)
“FDM has the lowest resolution and accuracy when 
compared to SLA or SLS and is not the best option 
for printing complex designs or parts with intricate 
features (Figure 4.37). Higher-quality finishes may 
be obtained through chemical and mechanical 
polishing processes. Industrial FDM 3D printers 
use soluble supports to mitigate some of these 
issues and offer a wider range of engineering 
thermoplastics, but they also come at a steep 
price.” (FormLabs, n.d.).

Figure 4.38: FormLabs. (n.d.). [Photograph of SLA 
parts showing a smooth surface that requires little 
finishing].

Figure 4.39: FormLabs. (n.d.). [Photograph of SLS 
parts showing a grainy surface, but are easy to 
finish].
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3.1 Mount bottom to saddle

2.1 Connect arms to torso

1.1 Apply suit to torso

1.2 Apply shoes to feet

1.3 Apply helmet to head

2.2 Connect legs to torso

2.3 Connect head to torso

3.2 Mount hands to bar

3.3 Mount feet to pedals

Concept 1: Perses Concept 2: Astraeus Concept 3: Pallas

Practical

Front-end fit

Mid-neck

Spring tension Press fit

Spring tension Press fit

Threaded

Thumb clamp

Ankle attachment

Open shape

Freely moving

Twisting sections

Shoulder-neck

Hinge Clamp

Hinge Clamp

Form-fit Clamp

Knuckle hinge

Flexible hip

Open shape

Shape optimized

Flexible shape

Jaw-neck

Form-fit Magnetic

Form-fit Magnetic

Press fit

Open hole

Flexible knee

Open shape

Figure 4.40: Idea combinations from the Morphological Chart for the Perses, Astraeus and Pallas concepts.

4.3 Personalized Mannequin: Development

4.3.5 Concept #1

Perses is unique in its hybrid-fabrication method. 
As a combination of additive and subtractive 
manufacturing, Perses combines the speed of CNC 
milling with the accuracy 3D printing. Interfaces 
such as joints and mount have elaborate features 
due to the possibilities of Stereolithography 3D 
printing. These parts have a smooth, untreated 
surface that requires no finish due to the material 
properties of the ABS-like resin. That allows for 
some pose adjustability, while limbs itself can 
remain large because they are CNC milled. That 
makes Perses an altogether practical mannequin 
with only a few extra fabrication steps.

Fabrication: CNC milling (limb sections) & 
Stereolithography 3D printing (interfaces).

Material: Polyurethane foam & ABS-like resin.

Finish: None for 3D printed parts. Coating for CNC 
milled parts.

Properties: Sophisticated interfaces & largely solid 
limbs. Regular features & adjustability, but the 
downside of multiple fabrication methods.

Figure 4.41: Visualization of the Perses mannequin concept. 

Analysis ConceptualizationIdeation
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Astraeus is unique in its elaborate product 
features. Completely 3D printed using Selective 
Laser Sintering, Astraeus utilizes the fabrication 
method with extensive pose adjustability. Its many 
limb segmentations are accurately adjustable with 
refined, rotating interfaces. Being SLS 3D printed 
from nylon powder, the mannequin has excellent 
material properties. However, individual part size is 
limited so large limbs will consist of multiple parts. 
The powder-like surface requires extra finishing, 
but it bonds excellently to coatings. That makes 
Astraeus a sophisticated mannequin with advanced 
features, only at the cost of more extensive 
manufacturing.

Fabrication: Selective Laser Sintering 3D printing.

Material: Nylon powder.

Finish: Sanding & coating.

Properties: Sophisticated interfaces & hollow, 
combined limb sections. Advanced features & pose 
adjustability, but sub-optimal fabrication method for 
a product of this kind.

4.3 Personalized Mannequin: Development

4.3.5 Concept #2

Figure 4.42: Visualization of the Astraeus mannequin concept.

4.3 Personalized Mannequin: Development

4.3.5 Concept #3

Pallas is unique in its overall simplicity and 
effectiveness. CNC milled from a block of 
foam, Pallas is manufactured quickly. With the 
mannequin’s primary function being its shape, 
CNC milling is inherently suitable for this purpose. 
With shape-fitting limbs and snap-fitting magnets, 
the mannequin assembles intuitively and fast. 
Polyurethane foam can be used untreated, 
but bonds well to coatings if durability is 
necessary. Its largest flaws are minimal interface 
and segmentation features due to fabrication 
constraints. On the other hand, CNC milling 
fabrication is especially efficient. That makes 
Pallas a simple, but effective mannequin that does 
exactly what is required.

Fabrication: CNC milling.

Material: Polyurethane foam.

Finish: Coating.

Properties: Simplistic interfaces & largely solid 
limbs. Essential features & limited adjustability, but 
efficient fabrication method for a product of this 
kind.

Figure 4.43: Visualization of the Pallas mannequin concept.

Analysis ConceptualizationIdeation Analysis ConceptualizationIdeation
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“A graphic representation of the strengths and 
weaknesses of design concepts with respect to 
predefined design requirements.” (Van Boeijen et 
al, 2020).

4.3 Personalized Mannequin: Development

4.3.6 Harris Profile
Desirability
Is your idea needed or wanted?
Does it resolve their problems?
Does the intended audience see its value?

Feasibility
Do you have the know-how, skills, resources and 
technology to deliver?
How realistically can you make it happen?

Viability
Does the business case stack-up?
Is it commercially or economically beneficial?
Is the business model sustainable?

A Harris Profile compares concepts by rating 
based on product desires. The desires are 
clustered and ordered hierarchically. The method 
rates concepts in relation to one another instead 
of by absolute weight. Ratings towards the right 
are positive, ratings towards the left are negative. 
The horizontal red bars show the range of ratings 
for each category of the Innovation Sweet Spot. 
The vertical red line shows the average rating for 
each category.

The ratings are generally favourable for concepts 
Perses (1) and Pallas (3) with Astraeus (2) scoring 
lower positive ratings and higher negative ratings 
(Figure 4.44). The latter specifically lacks in terms 
of Viability, suggesting it is not a sustainable 
solution like the other concepts. CNC milling 
is a more suitable fabrication method as the 
mannequin relies mostly on its shape rather than its 
advanced features.

Concept 1: Perses scores well, but lacks in terms 
of Feasibility and Viability. Concept 3: Pallas 
outperforms it in each category. This concept 
is recommended and discussed with the client 
halfway this project. Concept 3: Pallas is eventually 
selected, but redesigned once with the best 
features of the other concepts combined.

Desirability
Repeatability
Adjustability
Realism
Mounting
Assembling

Feasibility
Automated production
Accessible production
Fabrication speed
Cost efficiency

Viability
Environmental impact
Durability
Few separate parts
Space-efficiency
Weight

Concept 1: Perses Concept 2: Astraeus Concept 3: Pallas

Figure 4.44: Harris Profile concept selection.

-2 -1 0 1 2 -2 -1 0 1 2 -2 -1 0 1 2

Analysis ConceptualizationIdeation

The goal of the Harris Profile is to rate concepts 
based on the List of Requirements and select 
the best concept. Desires from the List of 
Requirements are clustered in three categories to 
evaluate the concepts for the innovation sweet 
spot: Desirability, Feasibility and Viability. The 
Human-Centred Design method by IDEO identifies 
the potential of an innovation if all three conditions 
are met. They can be tested by answering some 
of the following questions (PermissionToPlay, n.d.):
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Atlas is a redesign of the previously selected concept Perses. The Morphological 
Chart has been applied once again to generate a design based on the most 
favourable elements (Figure 4.45). The result is the Atlas mannequin design 
(Figure 4.46). This is the basis of the development phase later in the project.
 

4.3 Personalized Mannequin: Development

4.3.7 Redesign

Figure 4.46: Visualization of the Atlas mannequin concept.

3.1 Mount bottom to saddle

2.1 Connect arms to torso

1.1 Apply suit to torso

1.2 Apply shoes to feet

1.3 Apply helmet to head

2.2 Connect legs to torso

2.3 Connect head to torso

3.2 Mount hands to bar

3.3 Mount feet to pedals

Concept Redesign: Atlas

Figure 4.45: Idea combination from the Morphological Chart for Atlas.

Practical

Flexible shape

Jaw-neck

Form-fit Magnetic

Form-fit Magnetic

Form-fit Magnetic

Knuckle hinge

Ankle attachment

Open shape

Analysis ConceptualizationIdeation Iteration

Atlas is an evolution of the Perses concept, applying its hybrid-fabrication 
method to a preferred idea combina-tion. It utilizes the speed of CNC milling as 
much as possible, keeping limb segmentation and the required 3D printed parts 
to a minimum. This is possible due to the simplicity of all magnetic, form-fitting 
attachment inter-faces. Unlike Perses, Atlas uses Synthetic Laser Sintering for 
the excellent material performance properties of nylon PA12. Both CNC milled 
and SLS 3D printed parts work excellently with surface finishes for a smooth 
and functional mannequin. That makes Atlas the best of all previous mannequin 
designs.

Fabrication: CNC milling (limb sections) & Synthetic Laser Sintering 3D printing 
(interfaces).

Material: Polyurethane foam & Nylon powder.

Finish: Sanding and coating for 3D printed parts. Coating for CNC milled parts.

Properties: Sophisticated interfaces & 2-piece joined limbs. Regular features & 
adjustability, but the downside of multiple fabrication methods.
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4. Personalized Mannequin

4.4 Design Features
Methods from the development phase of this 
project lead to separately identified product 
features. Each feature is given individual attention 
to design it further. The design features are split 
into six groups: 3D Digital Model, Interaction 

Figure 4.47: Digital rider model of the mannequin. Figure 4.48: Mannequin limb segments.

3D Digital Model
The rider is 3D scanned and processed identically 
to the Generic Model, but several features are 
applied to it after. Segment faces are rounded with 
bevels and attachments slots are placed to attach 
the interfaces (Figure 4.47).

Interaction Segmentation
The mannequin requires segmentation to apply 
all cycling gear and to mount effectively to the 
bicycle. Considerations are made to achieve the 
best user interaction with the required product 
performance (Figure 4.48).

Figure 4.49: Attachment interfaces on all limbs.

Attachment Interfaces
The segmented limbs must be easily attachable 
and stay in place at all times. Each limb is analysed 
and several prototypes are made to develop the 
attachment interface (Figure 4.49). This includes 
testing with 3D printing and application of magnets.

Segmentation, Attachment Interfaces, Bicycle 
Mounts, Materials & Production and Full-Scale 
Prototype. Each design features is briefly 
discussed on this page and further in depth on the 
following pages.

Figure 4.50: Hand interface from flexible material.

Bicycle Mounts
The assembled mannequin mounts to the bicycle 
at three points and requires appropriate design 
features. The bicycle is analysed and three 
mounting interfaces are developed, focussing on 
attaching hands to the handlebar (Figure 4.50).

Figure 4.51: Segments from different materials.

Materials & Production
An ultra-personalized product with the size this 
mannequin is challenging to manufacture, so a 
study is conducted into materials & production. 
Experts are consulted and several materials are 
tested to design this feature (Figure 4.51).

Figure 4.52: Full-scale mannequin prototype.

Full-Scale Prototype
A full-scale prototype of the mannequin is 
produced in order to validate the designed 
features. Manufacturing a personalized mannequin 
is complex and the process is described in detail 
Figure 4.52).
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The procedure to capture and process the 
digital model is identical to the workflow of the 
Generic Model. The 3D scanning participants 
posed naturally to capture a realistic model. The 
mannequin is modelled minimally to look as realistic 
as possible, but a few modifications improve 
user interaction and make this a better product. 
The modifications include the mesh applied to 
correspond the model, bevels near sharp edges 
and slots for the attachment interfaces.

Specifications
 • Natural cycling position
 • High drag leg position
 • Separated hands

 • Standardized hands, feet & face
 • Shoes replaced by feet
 • Bicycle attachments removed
 • 50K Uniform, triangle mesh

Mesh
A 50K resolution, uniform, triangle mesh 
corresponds the processed model. The mesh is 
smoothened to hide individual facets (Figure 4.53). 
Hands, face and feet are standardizations of the 
3D scan data to improve their quality. Shoes are 
replaced removed to show bare feet. The model is 
scaled and oriented correctly and is otherwise left 
untouched.

4.4 Personalized Mannequin: Design Features

4.4.1 3D Digital Model

Figure 4.53: Original mesh (left), 50K vertex resolution mesh (middle) and 50K smoothened mesh (right).

Rider6-Corrected

Cyclist_TT_Wrap_Projectgeom1_Iteration2_03

GenericModelTT-Correction

Pose
The participating rider is holding his natural 
cycling pose in high drag position, with the left leg 
stretched and the right leg retracted (Figure 4.54). 
Unlike many riders’ personal preference, the hands 
are separate and do not cover each other. This 
ensures better attachment to the bicycle. The rider 
is wearing a head cap to hide his hair.

Bevels
The model is segmented for interaction and 
rounded bevels are added to the segment faces 
(Figure 4.55). A fillet of 2.5 mm ensures tight 
cycling suits can smoothly slide over the edges 
without catching. Bevelled segment seams are 
hidden below the suit when the mannequin is 
dressed. A straight-edge bevel is used for the 
prototype to FDM 3D print without requiring 
support structures.

Figure 4.54: A rider model in high drag leg position. Figure 4.55: Bevels applied to the segment faces 
of the upper legs.

Figure 4.56: Recessed attachment slots in the 
upper arms of the torso.

Attachment Slots
Recessed attachment slots are added to the 
segment faces (Figure 4.56). The slots include 
screw socket holes. The attachment interfaces are 
added during assembly of the product and can be 
replaced in this manner. Slots are included for both 
male and female side of the attachment interface 
for correct positioning.
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The mannequin is segmented for user interaction 
with separate legs, arms and hands (Figure 4.57). 
The leading requirement is that a cycling suit must 
be applied to the mannequin, so legs and arms are 
detachable. The wrists are segmented for easy 
mounting to the handlebar and better repetition 
of the mannequin’s position on the bicycle. The 
amount of separate limbs is kept to a minimum for 
ease of use and optimal product performance.

Arms
Orientation: Horizontal
Position:   Protrusion of 55 mm
Interface:  Recessed in torso

Legs
Orientation: Perpendicular to limb direction
Position:   Halfway between crotch & knee
Interface:  Recessed in torso

Hands
Orientation: Vertical
Position:   Wrist
Interface:  Recessed in arm

Overall
Bevel of 2.5 mm on segment edges

4.4 Personalized Mannequin: Design Features

4.4.2 Interaction Segmentation

Figure 4.57: Segmentation of the mannequin in time trial pose.

Analysis
Interaction
The segmentation of the mannequin is based 
primarily on the cycling kit it is required to wear. 
The defining garment is the cycling suit, consisting 
of a connected pair of shorts and jersey. The suit 
is impossible to apply to a one-piece mannequin 
and requires segmentation of the legs and arms. 
Protrusion of the legs and arms from the torso 
must be minimized for easy application of the suit 
and optimized for easy attachment of the limbs.

A long-sleeve time trial suit (Figure 4.60) is the 
most challenging garment to apply. Regulations 
in professional cycling are defined by the 
International Cyclist Union. According to Article 
1.3.026 of Clarification Guide Of The UCI Technical 
Regulation:

“When competing, all riders shall wear a jersey with 
sleeves and a pair of shorts, possibly in the form 
of a one-piece skinsuit. By shorts it is understood 
that these are shorts that come above the knee. 
Sleeveless jerseys shall be forbidden.”

Performance
The segmentation is also based on the loads 
applied to the mannequin during use. The defining 
elements are connections points to the bicycle 
and the mannequin’s centre of mass. Air resistance 
is of negligible influence in relation to the other 
forces on the mannequin, despite it being the 
product’s research purpose.

Contact area and attachment plane angle must 
be optimized for reliable attachment of the limbs. 
Free-body diagrams of the time trial (Figure 
4.58) and the road pose (Figure 4.59) show the 
difference between the two.

Most of the mannequin’s weight is supported by 
the saddle, which is balanced by the mounts to 
the pedals. The road pose has only one support 
point for each arm, which is distanced far from 
the mannequin’s centre of mass. This means a 
longer Moment Arm, resulting in a larger Moment 
of Inertia. The road pose therefore requires the 
appropriate design features near the arms and 
hands to support the loads.

Figure 4.60: A time trial cycling suit with long 
sleeves.

Figure 4.58: Free-body diagram of the mannequin 
in time trial position.

Figure 4.59: Free-body diagram of the mannequin 
in road position.
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Concept
A concept visualization shows limb segmentation 
of the mannequin (Figure 4.61). The image only 
shows the road pose, but segmentation applied to 
the time trial pose is almost identical.

An essential design element is the limb protrusion 
from the torso used to roll the garment’s sleeves. 
There must be sufficient space to clear the 
attachment interface for easy interaction.

The legs itself are not segmented and they remain 
mounted to the pedals during any interaction, 
unless the socks or shoes are changed. That 
involves their placement on the ground upon 
detachment of the torso.

The arms, on the other hand, are segmented from 
the hands. The reason being that the hands are 
the only mounting point to the bicycle that are 
significantly different for a mannequin than for a 
human subject (they involve hand muscle force). 
The hands can be mounted firmly with the first 
interaction, making the mannequin’s position more 
easily repeated in the following interactions.

Figure 4.61: Segmentation of the mannequin in road pose.

Interaction
To research how much limb protrusion from the 
torso is required for a proper fit of the suit, a 
simple test is performed. A representative subject 
(length 194 cm, mass 70 kg) is dressed in a time 
trial suit (size M) and rolled back the sleeves as far 
as possible.

Orientation
As is apparent in Figure 4.64, the arm and leg 
sleeve edges sit perpendicular to the protruding 
limb. From the clothing perspective it is therefore 
effective to segment as such.

Bevel
Evaluation of the Dumoulin Mannequin has 
indicated that sharp segment edges catch the 
cycling suit during application of the garment 
(Figure 4.62). A bevel is therefore applied to 
round the edges. The downside is the inaccurate 
depiction of the human body, but the interactive 
upside is preferred in this situation. A bevel of 
2.5 mm is applied to the segment edges for 
easy garment application, minimizing geometry 
manipulation while maximizing contact area 
between limbs.

Legs
As for the position of the segmentations, there 
must be a margin between sleeve end and 
segment edge. The legs are less critical limbs 
as the suit is more easily applied there. Extra 
protrusion is preferred here, as the bib may 
interfere between the legs. Segmentation is 
therefore applied halfway between the crotch and 
the knee. The attachment interface is recessed on 
the side of the torso.

Arms
The arm are more critical limbs as the suit is most 
challenging applied here. The shoulders are the last 
body part covered and the suit has become tighter 
as a result. Evaluation of the Dumoulin mannequin 
has indicated that his arms protrude too much 
(Figure 4.63). Based on the test and by digitally 
measuring the dimensions, an arm protrusion of 
55 mm is determined. The attachment interface is 
recessed on the side of the torso.

Figure 4.64: Representation of a cycling pose with 
the suit’s sleeves rolled far back.

Figure 4.62: Sharp edges of the Dumoulin 
mannequin’s torso catch the suit.

Figure 4.63: Long arm protrusions make the suit 
challenging to apply around the shoulders.

Hands
The hands are less critical limbs as it comes to 
applying the suit as it is only influenced by the 
sleeve end. The UCI states that:

“By jersey with sleeves it is understood a jersey 
that leaves hands not covered. Consequently, 
integrated gloves in a jersey or a skinsuit are 
prohibited.”

Therefore, it is most optimal to segment the arm 
at the wrist joint. This limits the size of the hand 
interface and the attachment interface is therefore 
extended on this end of the limb.
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Performance
From the performance perspective a different 
segmentation approach is apparent. It may be 
used to adjust decisions made based on user 
interaction alone.

As only vertical loads affect the mannequin, 
horizontal segmentation is most effective. This 
avoids any different loads from forming.

Legs
For the legs, this differs significantly from the 
perpendicular segmentation determined previously. 
However, the legs are used mostly to balance 
the mannequin rather than to carry its weight as 
that is mostly carried by the saddle. Therefore 
performance quality is less important than 
interaction quality in this case. The legs remain 
segmented perpendicularly to their limb direction.
 

Arms
For the arms, this differs less from the 
perpendicular segmentation determined previously. 
It was also identified as a critical area in the free-
body diagrams. Therefore performance quality is 
more important than interaction quality in this case. 
The arms are segmented horizontally.

Hands
For the hands, this differs significantly from the 
perpendicular segmentation determined previously. 
As horizontal segmentation would influence the 
interaction so significantly, a vertical segmentation 
is applied to the hands. This requires a strong 
attachment interface, but avoids any sliding if 
designed appropriately.

Figure 4.65: Standing pose with the suit’s sleeves 
rolled back as far as possible.

Figure 4.66: Visualization of the analysis and 
design process of the Interaction Segmentation.
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4.4 Personalized Mannequin: Design Features

4.4.3 Attachment Interfaces
The mannequin has magnetic, form-fitting 
attachment interfaces to easily assemble and 
disassemble the limbs (Figure 4.67). A pair of 
interfaces consists of a male & female side, 
identical for each Personalized Mannequin. The 
interfaces are fitted with a pair of N35 Neodymium 
magnets with alternating positive & negative poles 
for a guided attachment.

The attachment interfaces come in three sizes 
optimized for the legs, arms and hands. The shape 
is based on the cross-section profile of each one, 
maximizing surface contact area. All interfaces 
have a rounded shape to fit the CNC milled 
attachment slot. This also guides the interface form 
during attachment, just like the chamfered wall.

Screw sockets are included in the interfaces for 
fastening to and removing from the limbs. Colour 
coding is applied to distinguish left and right limbs. 
The attachment interfaces are SLS 3D printed from 
PA12 for high strength material properties. The 
limbs have recessed attachment slots to place the 
attachment interfaces.

Specifications
Wall thickness: 1 mm
Corner radius:  Ø 5 mm
Screw offset:  5 mm
Screw socket:  Ø 8 mm
Screw hole:   Ø 4 mm
Magnet socket: Ø 21 mm
Magnet depth:  3 mm Figure 4.67: Design of the arm attachment interface on various limbs.

Figure 4.68: Cross section of the arm interface.

Figure 4.71: Arm interface during attachment.

Figure 4.69: Cross section of the leg interface.

Figure 4.73: Wrist interface during attachment.

Figure 4.70: Cross section of the wrist interface.

Figure 4.72: Leg interface during attachment.

Attachment Slot Arm
The arm attachment interface (Figure 4.71) has two 
magnet slots (Figure 4.68). Alternating poles allow 
for a fit in only one orientation. Two screw slots fit 
exactly in available space between the magnets. 
As the cross section is relatively small, it is enough 
to hold the interface in place.

Length:  60 mm
Width:  45 mm
Height:  20 mm

Attachment Slot Leg
The leg attachment interface (Figure 4.72)has four 
magnet slots, because the extra space available 
(Figure 4.69). The magnets are maximally spaced 
to utilize the magnetic force during attachment. 
Alternating poles allow for a fit in only one 
orientation. Due to its large size, the leg interface 
is somewhat flexible. Four screw slots hold the 
interface effectively in place.

Length:  120 mm
Width:  90 mm
Height:  20 mm

Attachment Slot Wrist
The wrist attachment interface (Figure 4.73) only 
has one magnet slot (Figure 4.70). Subsequently, 
the interface has no alternating poles. Two screw 
slots fit exactly next to the magnet. The cross 
section of the wrist is so small that this interface 
uses all the available space.

Length:  39 mm
Width:  23 mm
Height:  20 mm
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Prototyping
Modelling
The development process of the attachment 
interfaces focussed on the arm as most force is 
applied to it. The interfaces of the leg and wrist are 
based on this design. The three differ primarily in 
the available contact surface between the limbs. 
Legs have a large cross section and are easy to 
work with, while wrists have a small cross section 
and are more challenging. 

Figure 4.74: Male side of the interface modelled in 
SolidWorks.

Figure 4.75: Slice the model and adjust settings to 
automatically generate a 3D print command.

The attachment interfaces are digitally modelled 
in SolidWorks to their exact dimensions (Figure 
4.74). The mod-els are exported as STL files. 
The exported files are loaded in Ultimaker Cura. 
The Support and Adhesion boxes to generate a 
brim on the print bed and support structures for 
overhanging features (Figure 4.75). The models are 
exported as G-code files.

Fabrication
Cura 3D print settings.

 • Material:   PolyLactic Acid filament
 • Machine:   Ultimaker 2+
 • Nozzle:   Ø 0.4 mm
 • Layer height:  0.15 mm
 • Time:   2-3 hours

The brim and supports are easily removed with a 
pair of pliers. Rough edges or filament remains are 
quickly finished with sanding paper (Figure 4.77).

Figure 4.76: The object is FDM 3D printed layer by 
layer.

Figure 4.77: After removing the brim and support, 
the result needs little finish.

Assembly
Adhesive neodymium magnets with N35 strength.

 • Square: 20 x 20 x 1 mm
 • Round: Ø 18 x 2 mm
 • Round:  Ø 20 x 2 mm

The magnets are easily applied to the inside of the 
attachment interfaces (Figure 4.78). The adhesive 
works effectively to keep the magnet in place. 
They also keep themselves in place due to the 
magnetic field. They are out of the way of any 
direct attachment mechanism. The round magnet is 
significantly stronger, because it is twice as thick.

Figure 4.78: N35 neodymium magnets applied to 
the attachment interfaces.

Figure 4.79: The first attachment prototype. Figure 4.80: The second attachment prototype. Figure 4.81: One of the screw sockets broke off 
while removing support of the third prototype.

Prototype #1
Height:  10 mm
Chamfer: 10 mm
Wall angle: 45 ˚

The first prototype (Figure 4.79) is a successful 
start. The interface has a good form-fit, but it is 
quite shallow. It therefore easily detaches.

The interface has right angles near the top which 
must be removed in order to fit a milled limb. 
The right angles of the attachment surface are 
effective however.

Prototype #2
Height:  15 mm
Chamfer: 9 mm
Wall angle: 60 ˚

The second prototype (Figure 4.80) is a significant 
improvement over the first. Its steep walls give the 
attachment a firm fit. It also finds and retains its 
position well.

Its four screw sockets may be effective, but not 
so efficient. It would be interesting to find if even 
steeper walls perform better.

Prototype #3
Height:  20 mm
Chamfer: 5 mm
Wall angle: 75 ˚

The third prototype (Figure 4.81) has large screw 
sockets. These structures require support during 
3D printing which are hard to remove afterwards. 
One of the sockets broke as a result. When 
positioned towards the edge of the interface, it is 
supported better and can decrease in size.

The walls of this prototype are so steep that 
attaching becomes difficult. The extra attachment 
surface does not seem to provide a better fit.
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Figure 4.82: Fourth design attached to a block of 
wood.

Prototype #4
Height:  20 mm
Chamfer: 10 mm
Wall angle: 63 ˚

The fourth prototype (Figure 4.82) falls within outer 
dimensions 60 x 40 mm with a 2 mm brim. It has 
only two screw sockets, but they have increased 
in size. They are also more effectively embedded 
in the wall’s shape. The interface’s corners have a 
larger rounding than before for a better form-fit.

Screws insert successfully into the sockets. The 
interface attaches firmly to the wooden blocks. 
The shapes find their fit well and release by pull 
or rotation. A single magnet works, but a set of 
magnets works even better. It limits rotational 
movement and only attaches in one orientation. 
The magnets could use a dedicated slot to 
increase contact area between the attachment 
and parent object.

Figure 4.83: Fifth attachment interface attached to 
a block of wood.

Prototype #5
Height:  20 mm
Chamfer: 5 mm
Wall angle: 75 ˚

The fifth prototype (Figure 4.83) has steep walls 
once again, but with integrated screw sockets. 
The sockets are positioned on the long edge as 
opposed to the shorts edge previously, optimizing 
space left by the pair of magnets. The interface 
also has dedicated slots for the magnet pairs. A 
large variant for leg attachment is also fabricated 
with the same design (Figure 4.87).

Changes to the screw sockets and magnet 
slots prove to be significant improvements. The 
interface still attaches well to the parent object, 
despite the screws being moved. The magnet 
slots may be a little deeper, because the magnets 
still protrude from the interface. The large variant 
for leg attachment turned out well too, but is a lot 
more flexible. This may be resolved by attaching 
it to the parent object or by adding supporting 
elements.

Figure 4.84: Sixth attachment interface attached to 
a block of wood.

Prototype #6
Height:   20 mm
Chamfer:  5 mm
Straight edge: 10 mm

The sixth prototype (Figure 4.84) has both a 
chamfer and a straight edge. This is designed 
to have the same ease of use with better 
performance. The magnet slots are deeper and 
fully enclosed. The interface has an improved 
base plate with more contact area to the intended 
attachment slot. It is both FDM and SLS 3D printed 
to study difference in performance (Figure 4.88).

The straight edges of the interfaces make 
attachment firmer, but they are still easy to apply. 
A significant difference is noticeable between the 
FDM and SLS 3D printed parts, where the latter 
is more accurately fabricated and fits better. The 
base plate is an improvement as the magnets are 
properly recessed.

Figure 4.88: Sixth attachment interface FDM 
(yellow) and SLS 3D printed (black).

Figure 4.85: Fourth attachment interface, female 
half.

Figure 4.86: Fourth attachment interface, male half.

Figure 4.87: Large variant of the fifth attachment 
interface.

Figure 4.89: Design of the arm attachment interface on various limbs.



Figure 4.90: Visualization of the analysis and 
design process of the Attachment Interfaces.
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4.4 Personalized Mannequin: Design Features

4.4.4 Bicycle Mounts
The mannequin is mounted to a bicycle without 
any modifications. That means it utilizes identical 
contact point a live rider does: the saddle, the 
pedals and the handlebars.

Saddle
No design features are applied to the bottom of 
the mannequin, so it simply rests on the saddle 
(Figure 4.91). This mounting point carries most 
weight of the mannequin, but is stabilized by 
the arms and mostly the legs. Evaluation of the 
Dumoulin Mannequin indicates this design functions 
well and it is consequently applied to Rupert.

Figure 4.91: The bottom of the mannequin simply 
rests on the saddle.

Pedals
The function of the mannequin is to wear cycling 
gear, shoes included (Figure 4.92). Cycling shoes 
use a clipping mechanism to mount to pedals 
that firmly attaches, but easily detaches. Such 
shoes are made to fit the rider’s feet and are 
consequently the perfect method to mount the 
mannequin to the pedals. Several competitors 
apply the same design successfully. Rupert’s feet 
are therefore shaped and sized accordingly.

Handlebar
The most critical bicycle mounting point is the 
handlebar, as live riders grip it with the force of 
their hand muscles. It therefore has the most 
challenging mounting interface out of the three. 
Two design directions are explored in this project: 
an adjustable mechanism with a hand-shaped 
cover (Figure 4.94) and a hand shape from flexible 
TPU material (Figure 4.95).

Figure 4.92: Cycling shoes are used to mount the 
feet to the pedals.

Figure 4.93: Flexible hands fold around the 
handlebar and attach to the arm.

Mechanical
This design direction uses rubber-coated pipe 
clamps with an adjustable hinge mechanism for 
accurate positioning and repetition of the hand 
interface. The mechanism is covered by hand-
shapes shell to take the right form.

The mechanical mounting mechanism is developed 
with sketches and by reviewing hardware, but 
the design direction is ultimately dropped as it is 
deemed too complex. Large forces rest on the 
handlebar and such a refined mechanism therefore 
requires a sophisticated and strong design. A 
simplified design direction is researched instead.

Flexible
This design direction uses SLS 3D printed, flexible 
TPU to grip the handlebar with a hand-shape 
only. This rubber-like material has high elasticity 
and fatigue resistance (Oceanz, n.d.). The hand 
interfaces has a wall thickness of 4 mm, making 
it flexible enough to grab the handlebar and stiff 
enough to hold it.

The hand interface is originally 3D printed without 
holes, meaning all TPU powder remains between 
the walls of the object. This makes the hand less 
flexible than desired. The powder is removed 
by drilling a hole in the segmented face. Other 
properties such as wall thickness or internal 
structures influence the flexibility of the hand and 
may be optimized as such.Figure 4.95: A hand made of flexible TPU.

Figure 4.94: Technical sketches of the mechanical hand interface.



Cyclist Mannequin - Siward Vloemans 97Cyclist Mannequin - Siward Vloemans96

4.4 Personalized Mannequin: Design Features

4.4.5 Materials & Production
The mannequin is CNC milled from high density 
polyurethane tooling board (Figure 4.96). This 
material lends itself excellently to subtractive 
manufacturing, because it can be produced in a 
variety of specifications and it has great material 
properties.

Figure 4.95: Three CNC milled and one 3D printed lower arm segments. Figure 4.96: Two arm segments are CNC milled.

High density polyurethane is a heavy, closed-
cell foam (Figure 4.95), unlike the soft, open-cell 
foam that is often used in packaging. Comparable 
to wood, it is hard to the touch. Unlike wood its 
material properties can be greatly manipulated, 
making it suitable for design studies, prototyping & 
wind tunnel models.

Specifications
Fabrication: CNC Milling 5-axis (1-3 mm margin 
rough cut & ball-end mill fine cut).
Material:  High density polyurethane, closed-cell 
tooling board 470 kg/m3.
Bonding: Polyurethane room-temperature cure 
adhesive.
Finish: Light sanding.
Coating: Foam surface sanding sealant, surface 
primer & matte black paint.

“High-density polyurethane foam is a popular choice in the tooling industry because it does 
not outgas during heating, is dimensionally stable, has a predictable coefficient of thermal 
expansion (CTE), and has a fine/smooth surface finish.” (General Plastics, 2018).

Expert Recommendations
About a dozen companies are contacted for 
advice about fabrication and material selection. 
Three of them (VIBA, Scabro & Jules Dock) 
respond with recommendations about high density 
polyurethane tooling boards. All three recommend 
similar foam densities for the mannequin.

VIBA:    500  kg/m3
Scabro:   350 – 470 kg/m3
Jules Dock:  450 kg/m3

VIBA and Scabro supplied samples of the 
recommended materials. Lower arm segments 
are CNC milled from RAKU-TOOL 0240, 0351 
& 0470. Following the advice combined with 
experiencing one of the tooling boards, the high 
density polyurethane 470 kg/m3 is selected for 
the mannequin.

Prototyping
Three polyurethane hard foam samples are 
ordered from Scabro, Dutch producer and supplier 
of industrial model-making materials. Scabro 
employee Franz Klotz recommends RAKU-TOOL 
PU foam in densities of 240, 351 and 470 kg/m3 
(Figure 4.97). The samples have dimensions of 
290 x 180 x 50 mm, precisely enough to CNC mill 
a lower arm from. The arm is segmented in length 
(Figure 4.98) to fabricate on a 3-axis CNC mill 
without orientation adjustments.

Material:    Polyurethane foam 351 kg/m3
Machine:    Roland 3-axis CNC mill
End Mill Cutter: Ø 10 mm, 50 mm length
Detail:    1.1 mm
Layer height:  5 mm
Time:     2-3 hours

The arm segments come out nicely after CNC 
milling (Figure 4.99). The high density foam is 
hardly grainy and shows fine surface details. Any 
excess foam is easily removed. The segments 
are joined by applying Bison Spray Glue. Sanding 
works effectively to finish the seams. The limb 
feels strong and stiff, but the milling paths clearly 
show on the surface (Figure 4.100).

Following the first arm segment, two more arms 
are CNC milled from the remaining polyurethane 
foam. Layer height settings in DeskProto are 
adjusted slightly to accommodate the differences 
in material density. These arm segments also come 
out nicely and make a good comparison between 
the foam types in the right context (Figure 4.95).

Figure 4.97: RAKU-TOOL PU foam samples.

Figure 4.98: An arm segmented to fit the foam.

Figure 4.99: Removing segments from milling bed.

Figure 4.101: Obomodulan & RenShape samples.

Three more polyurethane hard foam samples are 
ordered from VIBA, Dutch specialist in fasteners 
and bonding. VIBA employee Ritish Raghoebier 
recommends PU foam by Obomodulan and 
RenShape in densities of 500, 650 and 720 kg/m3 
(Figure 4.101). The samples have dimensions of 120 
x 50 x 10 mm, too small to CNC mill from. However, 
the samples are a useful tool to experience the 
differences between foam types.

Figure 4.100: Milling marks on the arm segment.
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4.4 Personalized Mannequin: Design Features

4.4.6 Full-Scale Prototype
The full-scale prototype of the Personalized 
Mannequin takes two weeks to create from first 
3D prints to final assembly. The FDM 3D printing 
process takes 261 hours including retried prints on 
two Ultimaker Extended 2+ with large nozzles on 
extreme settings. The process involves fabricating 
all parts, treating the surfaces for inaccuracies, 
joining the segments, filling any seams, painting the 
parts and assembling the product. 

Parts of the mannequin are produced differently 
with the purpose of comparing results and 
managing time. The production process is 
prepared by fabricating separate limb segments. 
Consultation with Joris van Tubergen and PMB 
staff is invaluable in the production of this 
prototype. The full-scale prototype is used to 
validate the design of the mannequin on a bicycle 
(Figure 4.102).

Figure 4.102: The full-scale prototype assembled on a time trial bicycle.

Consult Wiebe Draijer
3D Printing expert Wiebe Draijer from the Model 
Making Machine Lab of the TU Delft is consulted. 
He mentions that most time can be saved by using 
a large nozzle, limiting the amount of wall layers 
and by experimenting with infill settings.

Wiebe Draijer’s advice it to use the latest Cura 5.0 
(beta) software as its algorithm optimizes printing 
speeds locally. Advanced settings can be accessed 
in the ‘Settings Visibility’ menu. Despite there being 
too many settings to study, a few relevant ones 
may prove valuable.

Lastly infill settings greatly affect fabrication time 
and product performance. A standard, 10% square 
infill already performs well enough. However, 
the Gyroid infill pattern supports loads from all 
directions. By applying Gradual Infill Steps, supports 
are maximized near surfaces and minimized near 
the object core.

Cura 3D print settings.
 • Nozzle size: 0.8 mm
 • Layer height: 0.2 – 0.4 mm
 • Wall thickness: 1 – 2 mm
 • Infill:  gradual infill steps

Before the entire mannequin is fabricated full-scale, 
several separate limbs are fabricated individually. 
These are used to experiment with 3D printer 
settings and finishing methods, as well as functional 
analysis such as attaching to other limbs and 
mounting to the bicycle.

All limbs are initially fabricated on Ultimaker 2+ 
FDM 3D printers with standard 0.4 mm nozzles and 
white PLA filament.

Testing
All initial Digital Fabrication is performed with 
standard Ultimaker 2+ 3D printers.

Arms
Cura 3D print settings.

 • Layer height: 0.15 mm
 • Infill:  10 %
 • Support:  no
 • Adhesion:  no

To fabricate a full-scale arm with an Ultimaker 2+, it 
is segmented in three sections (one for the upper 
arm, two for the lower arm). By segmenting the 
limb cleverly it requires minimal support, minimizing 
fabrication time. The limb utilizes most of the 
Ultimaker 2+’s building volume (Figure 4.103).

With the 3D print settings, the arm is fabricated 
in about 33 hours. Cura gives warnings where 
support would be required and this results in small 
failures (Figure 4.104). Overall the models turned 
out well with little manual post-processing required. 
All limbs are preferably 3D printed without support 
or brim if their shape allows it.

The limb segments are attached using plastic 
model glue (Figure 4.105). The surfaces are lightly 
sanded for optimal adhesion. The segments are 
easily oriented because of the arm’s shape. A 
form-fit would be a valuable addition to the model 
glue to enforce the connection.

Figure 4.105: Upper, middle and lower arm 
segments glued together.

Figure 4.104: A small failure in the upper arm where 
support is required.

Figure 4.103: Three arm sections exactly fit the 
build volume of the Ultimaker 2+.
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Hands
Cura 3D print settings.

 • Layer height: 0.15 mm
 • Infill:  20 %
 • Support:  yes
 • Adhesion:  yes

Lots of support was added to the hands in 
Cura to 3D print the overhanging shapes. This 
requires a lot of finishing post-fabrication. Even 
after the necessary processing, lots of support 
remains between the fingers (Figure 4.106). These 
areas are so hard to reach that correct removal 
becomes impossible. This significantly affects the 
performance of the limb as the palm of the hand 
is required for connection to the handlebar. An 
alternative fabrication method is desired for this 
limb.

Figure 4.106: Remains of the supports are clearly 
visible near the fingers.

Foot 1
Cura 3D print settings.

 • Layer height: 0.2 mm
 • Infill:  10 %
 • Support:  yes
 • Adhesion:  yes

A size 40 foot exactly fits the 3D printing volume 
of the Ultimaker 2+. It is printed in the natural 
orientation with supports below the sole (Figure 
4.110). Because of the shape’s complexity, the 
supports cover the entire sole. Removing it is not 
too much work, but leaves a rough surface (Figure 
4.107). Such a finish is not desired and requires 
too much work to finish properly. Alternatively, the 
foot may be segmented horizontally and joined 
afterwards to improve this workflow.

Foot 2
Cura 3D print settings.

 • Layer height: 0.4 mm
 • Infill:  10% gyroid
 • Support:  no
 • Adhesion:  no

The foot is segmented horizontally for this 
prototype, allowing the models to be 3D printed 
without support. The sole requires less finish this 
way. Time efficient printing settings are used, such 
as 10% gyroid infill (Figure 4.110). The layer height 
turns out too high for this nozzle. Holes appear 
near flat sections of the model (Figure 4.108). A 
layer height of 0.3 mm is about the maximum for 
a 0.4 mm nozzle, where a layer height of 0.4 mm 
could be used with a 0.8 mm nozzle.

Figure 4.107: A rough surface remains after 
removing all supports.

Figure 4.108: Holes appear near flat sections 
because of the layer height setting.

Figure 4.110: Gyroid infill of 10%.Figure 4.109: A left foot 3D printed vertically.

Modelling
All modelling tasks for the full-scale prototype are 
performed in Blender as recommended by Joris 
van Tubergen.

Model Transformation
The rider model is scaled and oriented incorrectly 
after corresponding in Wrap. A transformation is 
applied to correct the model before editing.

 • Object > Transform
 • Apply > All Transforms

Segmentation - Interaction
Apply planes to the model where segmentation 
is required (Figure 4.111). Split the model into 
segments and separate into parts.

 • Add > Mesh > Plane
 • Modifier > Solidify
 • Modifier > Boolean Difference
 • Edit > Mesh > Separate > By Loose Parts

Round Edges
Select the segmentation surfaces for each limb 
segment and apply bevels (Figure 4.112).

 • Object Data > Add Vertex Group
 • Modifier > Bevel Edge

Amount:    0.0025
Segments:   1
Limit Method:  Vertex Group
Clamp Overlap: No
Loop Slide:   No
Harden Normals: No

Attachment Slots
Load and position SVG files of the attachment 
interfaces (Figure 4.113).

 • File > Import > SVG
 • Object > Convert > Mesh
 • Object > Join
 • Transform > Move > Snap To SurfaceFigure 4.111: Segmentation planes positioned 

through the model.

Figure 4.112: Bevels applied to the segment edges.

Figure 4.113: Sizing a placed attachment slot.

Size the interface and cut the attachment slot from 
the model (Figure 4.114).

 • Transform
 • Duplicate Collection
 • Modify > Solidify
 • Boolean > Difference

Figure 4.114: Attachment slots applied to the torso.
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Segmentation - Fabrication
Add the volumes of available 3D printers to use for 
segmentation (Figure 4.115).

 • Add > Mesh > Cube
 • Object > Transform

Figure 4.115: Rider model and box representations 
of the Ultimaker 2+, 2 Extended and S5.

Choose segmentation planes and position 3D 
printer volumes to segment the entire model 
(Figure 4.116).

 • Modify > Boolean Intersect

Figure 4.116: Torso box segments.

Detailed Mesh
As soon as an improved version of the model 
is ready, it can replace remaining limbs of the 
original model. The detailed mesh model is used 
for fabrication of the head and arms in this project 
(Figure 4.117).

Figure 4.117: The model’s head and arms have a 
more detailed mesh.

Consult Joris van Tubergen
Joris van Tubergen is the co-creator of the 
Dumoulin mannequin and specializes in FDM 3D 
printing on large scale. He uses inverted Ultimakers 
to fabricate to infinite length and has a large 3D 
printer that can fabricate up to 60 x 60 x 100 cm.

Joris van Tubergen’s advice is to reduce 3D 
printing time of individual parts to a maximum of 1.5 
to 2 days. This is to reduce risks with the chances 
of failure during fabrication.

One way to reduce fabrication time is to increase 
fabrication speed. The best method is to increase 
nozzle size and layer height. This creates a rougher 
surface finish, but favourable material strength. 
Different sections of the same part may be 3D 
printed with different speeds, depending on the 
complexity of each section.

Another way to reduce fabrication time is to 
reduce fabrication volume. The best method is to 
minimize infill and to avoid supports. The latter has 
the added advantage that little to no surface finish 
is required without supports. They can be avoided 
by 3D printing in multiple segments. Alternatively, 
they can be optimized by using tree-supports from 
Meshmixer.

Cura 3D print settings.
 • Nozzle size: 0.8 – 1 mm
 • Layer height: 0.4 mm
 • Wall thickness: 2 layers
 • Infill:  minimal
 • Support:  minimal to none

Digital Fabrication
Digital Fabrication of the full-scale prototype is 
performed with a variety of Ultimaker 3D printers.

Materials
Ultimaker 2+
223 mm × 223 mm × 205 mm

Ultimaker 2 Extended+
223 mm × 223 mm × 305 mm

Ultimaker S5
330 mm x 240 mm x 300 mm

Legs
Any available 3D printers in the Model Making 
Machine Lab are used to fabricate the pair of 
legs. (Figure 4.118). Because of the varying build 
volumes, limbs are individually segmented for each 
Ultimaker.

Cura 3D print settings.
 • Nozzle size: 0.4 mm
 • Layer height: 0.3 mm
 • Wall thickness: 2 layers
 • Infill:  10% gyroid
 • Speed:  60 mm/s
 • Support:  no
 • Adhesion:  raft

Total printing time: 76 hours. Two segments failed 
and are fabricated again. The legs came out nicely 
overall, because the 0.4 mm nozzle is accurate 
even with time efficient settings. However, 3D 
printing settings are still too slow to fabricate 
the torso. Therefore, dedicated Ultimakers are 
assigned with a larger nozzle.

Figure 4.119: An upper and lower leg segment 
completed by the Ultimaker S5.

Figure 4.118: Five Ultimakers (2+, 2 Extended + and 
S5) 3D printing a pair of legs.
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Boventitel

Ondertitel
Torso
Two dedicated Ultimaker 2 Extended+ 3D printers 
are used to fabricate the torso (Figure 4.120). The 
standard 0.4 mm nozzle is replaced with an 0.8 
mm nozzle to increase speed. Other settings in 
Cura are changed to increase speed as well. The 
first 3D prints serve as a test to ensure the quality 
still suffices.

Cura 3D print settings.
 • Nozzle size: 0.8  mm
 • Layer height: 0.4 mm
 • Wall thickness: 2 layers
 • Infill:  5% gyroid
 • Speed:  80 mm/s
 • Support:  from build plate
 • Adhesion:  skirt

One of the torso segments has a rough surface 
finish on two sides (Figure 4.121). Nozzle vibrations 
were caused by play in the axle bearings. The 
bearings are replaced before the next 3D print. 
Print speed is decreased slightly as a test to 
prevent surface deformations.

 • Speed:  70 mm/s

Figure 4.120: Two dedicated Ultimaker 2 
Extended+ with large nozzles.

Figure 4.121: First torso segments suffer from 
surface errors.

Attachment Interfaces
As the interfaces not only have an aesthetic 
function, 3D print settings were adjusted to gain 
higher quality results. All attachment interfaces fit 
the print bed of the Ultimaker 2 Extended + (Figure 
4.122).

Cura 3D print settings.
 • Nozzle size: 0.8  mm
 • Layer height: 0.3 mm
 • Wall thickness: 2 layers
 • Infill:  10% grid
 • Speed:  60 mm/s
 • Support:  from build plate
 • Adhesion:  raft

Figure 4.122: All attachment interfaces on the print 
bed of the Ultimaker 2+ Extended.
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-
8.5
16
10.75
7.5
2.5
8,5
-
-
8
-
-
5
3.75
3.75
3.25
6
5.25
7
7
12.25
11
7.25
7
5.75
4
8
2.5
1
3.25
3.25
-
-
-
-

217.25

FDM 3D Printing Process (Hours) Consult Roland van der Velden
Production expert Roland van der Velden from 
the Model Making Machine Lab of the TU Delft is 
also consulted. He advises to use a quick-curing, 
budget adhesive to attach the torso segments 
due to the large connection surfaces. A PVC kit 
adhesive is available in the workshop. Roland 
recommends using weights and clamps to keep 
the segments in place as more parts are attached.

Furthermore, he mentions that seams will appear 
between segments of the torso. Wall filler is a 
user-friendly, budget solution to make the torso 
seamless. Applying a small amount of moisture lets 
the filler flow fluidly between the seams. After an 
hour of curing excess wall filler is simply removed 
by sanding.

After assembly, the torso must be finished and the 
rough surface requires some treatment. Roland 
recommends using spray putty to both prime the 
surface and to smoothen it. A light sanding must 
be applied between each layer and multiple layers 
are preferred. The torso may then be finished with 
two layers of paint and a transparent finish.

Production
All Production of the full-scale mannequin is 
performed in the Model Making Machine Lab.

Assembly
The mannequin is ready for assembly after 3D 
printing. Because of the high 3D printing speeds, 
all parts require surface and edge sanding before 
assembly. Tools used during assembly (Figure 
4.123): 

 • Pattex PVC kit adhesive
 • Alabastine wall filler
 • A variety of sanding paper
 • Weights & clamps

Every flat surface is sanded before applying kit. It 
is applied around the edges and near the centre of 
only one part (Figure 4.124).

The segmentation lines and base mesh give 
a visual indication of how to align all parts and 
assembly of the torso (Figure 4.125) is relatively 
simple. Seam lines are still clearly visible.

Figure 4.123: Supplies used to assemble the torso.

Figure 4.124: Applying kit to one of the surfaces.

Figure 4.125: The torso completely assembled.
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Wall filler is applied generously to all seams (Figure 
4.126) of the model and left to dry for about an 
hour.

After the wall filler has dried, all seams are sanded 
to remove any excess material (Figure 4.127). Wall 
filler now only remains inside seams.

Figure 4.126: Filled seams after light sanding.

Figure 4.127: Filled seams after complete sanding.

Finish
The mannequin is finished using three types 
of spray (Figure 4.128). Each spray is applied in 
layers with at least an hour of curing in between. 
Two layers of spray putty, three layers of matte 
black paint and one layer of transparent finish are 
applied. The spraying cabin in the Model Making 
Machine Lab is used to apply the spray (Figure 
4.129). The interface slots are masked while 
applying the spray putty.

 • Alabastine spray putty
 • OK matte black paint
 • OK transparent finish
 • Masking tape

Figure 4.128: Spray putty, matte black paint & 
transparent finish.

Figure 4.129: The torso in the spray cabin.

Figure 4.130: The torso after applying a layer of 
spray putty.

Figure 4.131: The torso after applying a layer of 
matte black paint.

Figure 4.132: Close-up of the torso after applying 
all layers of matte black paint.

The attachment interfaces are painted to indicate 
use cues. Interfaces for the left limbs are painted 
yellow, while interfaces for the right limbs are 
painted red (Figure 4.134). The interfaces are not 
primed, but a layer of transparent finish is applied.

Figure 4.133: The attachment interfaces before 
applying a layer of paint.

Figure 4.134: The attachment interfaces after 
applying a layer of paint.

Assembly
The mannequin is assembled after all parts are 
finished (Figure 4.135), meaning limbs segments are 
joined, seams are filled and the surface is sanded 
or painted. First, magnets are applied to the 
attachment interfaces (Figure 4.136).

The interfaces are designed to screw into 
dedicated slots integrated with the limbs. However, 
this is not possible due to multiple reasons. First, 
the interface slots of the legs are scaled incorrectly 
due to a modelling error. Second, the arm interface 
slots have the old screw positions by mistake. 
Lastly, some of the screw sockets broke off during 
support removal, because the supports are much 
larger with a 0.8 mm nozzle. Consequently, the 
interfaces are attached using plastic model glue 
and become non-removable. The slots are used to 
position the interfaces correctly (Figure 4.137).

After assembly is completed, the full-scale 
mannequin is finally finished (Figure 4.138).

Figure 4.136: Magnets are placed in dedicated slots 
of the attachment interfaces.

Figure 4.137: The interfaces are placed in the torso 
slots inversed to align them to the leg.

Figure 4.138: Fully assembled limbs of the full-scale 
mannequin.

Figure 4.135: All separate parts of the mannequin 
to assemble.
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Validation session conducted on Monday 20-06-
2022 with Wouter Terra & Harm Ubbens.

Introduction
This experiment aims to validate the design of the 
Personalized. Functionalities from the Function 
Analysis and desires from the List of Requirements 
are used to evaluate the desirability of the 
mannequin. The goal is to use the results to make 
recommendations about the development of the 
product. The research question is:

“How is the Personalized Mannequin experienced 
by users?”

Method
Participants
The research involves the participation of project 
clients and end-users Wouter Terra and Harm 
Ubbens.

Apparatus
 • Personalized Mannequin prototype
 • Time trial bicycle (rider-specific)
 • Cycling kit
 • Bicycle trainer stand

Stimuli
The participants are given tasks to perform based 
on the Function Analysis of the Personalized 
Mannequin. The tasks are:

4. Personalized Mannequin

4.5 Validation
 • Apply cycling gear (suit, shoes & helmet)
 • Connect limbs (hands, arms & legs)
 • Mount to bicycle (saddle, pedals, bars)

The participants perform the tasks together and 
are asked to think out loud. Comments are noted 
by the researcher. The interactions are recorded 
with a photo camera.

Procedure
Location: Faculty of Industrial Design Engineering.
Time: 13:00-14:00.

Preparation
The bicycle is installed in the trainer stand. The 
setup is positioned with room to walk around it 
(Figure 4.139). Limbs of the mannequin and the 
cycling kit are placed on a table separately.

Introduction
The participants are introduced to the purpose 
of the research. They are instructed about the 
activities to perform with the mannequin. The 
participants are asked to think out loud and are 
asked for permission to photograph the session.

Activities
The participants conduct the activities with the 
mannequin together (Figure 4.140). Comments 
are noted by the researcher and photos of the 
activities are also taken by the researcher.

Processing
The participants are asked about their first 
impression. They are also asked about the 
mannequin’s best features and about features to 
be improved. Lastly, the participants are asked to 
rate the desirability of the mannequin.

Figure 4.139: Bicycle and mannequin positioned 
with room to walk around.

Figure 4.140: Participants mounting the mannequin 
to the bicycle.

Data Collection
The participants answer open questions directly 
after the activities. The questions are:

How did you experience applying cycling gear?
How did you experience connecting limbs?
How did you experience mounting to the bicycle?

The participants rate several criteria on a Likert 
Scale from one (strongly disagree) to five (strongly 
agree). The criteria are desires from the List of 
Requirements.

The mannequin’s pose is accurately repeatable.
The mannequin’s pose is accurately adjustable.
The mannequin’s shape is accurately realistic.
The mannequin is quickly (un)mounted.
The mannequin’s limbs are quickly (dis)assembled.
 
Data Analysis
The ratings are analysed to validate desirability 
of the Personalized Mannequin. The ratings itself 
identify strengths and weaknesses of the design 
and are plotted in a histogram. Answers to the 
open questions are processed manually used to 
substantiate the quantitative data.

Results
Answers to the open questions are summed up for 
each of the activities in this research.

Apply cycling gear
The perpendicular segmentation plane of the legs 
is a preferable choice.
The bib of the suit is more challenging to apply 
than the sleeves, because the area between the 
legs is limited.
Arm protrusion is perfect. Short enough to apply 
the suit and long enough to roll the sleeves.
The bevel of the segment faces make clothes 
easy to apply. They are unobtrusive when the 
clothes are applied, but could be smaller.
The head is too large for the helmet and it sits 
awkwardly because of the head’s odd shape.

Connect limbs
All limbs connect easily, but are not connected well 
enough.
The arms are able to move and the legs require 
duct tape to stay connected.
The limbs do not connect seamlessly, which is an 
important desire.
The magnets could be more powerful, near the 
legs in particular.

Figure 4.141: Not enough space between the legs.

Mount to bicycle
The saddle does not fit well between the legs, 
because they are too close together (Figure 4.141).
The feet are too wide to fit a shoe and cannot 
be mounted to the pedals consequently (Figure 
4.142).
The hands are not modelled correctly, so the 
shape does not follow the handlebar well enough.
The mounting system is easy to use, but needs 
some refinement.

Likert Scale
Ratings of the desirability criteria are plotted 
in a histogram (Figure 4.143). Repeatability and 
realism are rated neutral (3) by both participants. 
Adjustability is rated negatively (2), while mounting 
and assembling are rated positively (4 & 5) by the 
participants. Participant 2 is most favourable about 
the last two criteria.

Figure 4.142: The feet do not reach the pedals.

Figure 4.143: Ratings of the desirability criteria.

Design: Rupert

Desirability
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Adjustability

Realism

Mounting

Assembling
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Figure 4.150: The head is oddly sized and the 
helmet does not fit properly.

Figure 4.151: The attachment interfaces have slack, 
causing the arms to move.

Figure 4.144: A participants sits on the torso to 
apply the suit easier.

Figure 4.145: Duct tape is applied to connect the 
legs more firmly.

Figure 4.146: The cycling suit sleeves have 
stretched during application.

Figure 4.147: The assembled mannequin has to be 
lifted over the bicycle.

Figure 4.148: The arms are asymmetric and the 
hands do not connect with the bar-ends.

Figure 4.149: The feet are too large to fit a cycling 
shoe.

Interaction Scenario Rupert #2
Harm Ubbens & Wouter Terra dress, 
assemble and mount Rupert to a 
time trial bicycle. Noteworthy and 
unintended interactions are described 
here.

Discussion
Discussion open questions
Applying cycling gear is experienced positively, 
but flawed. The participants applied the suit to the 
legs first, but the limited area between the legs 
made it challenging. The right leg was dressed 
before the left leg. Once applied to the legs, the 
suit was easily applied to the rest of the torso. The 
smooth surface, edge bevels and segmentation 
of the arms was perceived positively. However, 
the mannequin creaked under force and the 
suit stretched out around the sleeves during 
application. A participant mentioned that was also 
due to the quality of the garment. Applying the 
helmet gave more trouble as it did not fit the head 
correctly. The issue was caused by the large size 
and odd shape of the head.

Connecting limbs is experienced well, but 
performed poorly. The legs had to be fastened 
with duct tape as they did not hold together. That 
is also due to the lacking support of the pedals, 
which would normally help. The arms held in 
place, but caused slack and felt fragile. The hands 
connected best. Overall, the attachment system 
worked well for the participants, but they desired 
better performance. The participants suggested 
stronger magnets, a firmer form-fit and a stronger 
structure. The attachments must also connect 
seamlessly.

Mounting to bicycle is experienced user-friendly, 
but flawed. The participants applied the bottom of 
the mannequin to the saddle first, but the saddle 
was too wide. The mannequin was moved forward 
and tilted incorrectly on the bicycle as a result. The 
feet did not reach the pedals consequently, and 
they were too large to fit a shoe. However, the 
arms did reach the elbow rests and handlebars 
and the mannequin was stable overall. The flexible 
handlebar mount is experienced positively, though 
the participants mention the hands could follow the 
shape of the handlebar better. This caused worry 
about repeatability of the position. The participants 
mention flexibility would be preferable near the 
knee as well.

Discussion Likert Scale
Ratings from the Likert Scale confirm most of 
the aforementioned statements. Repeatability 
is rated neutral because the mannequin did not 
seamlessly connect to the bike. Adjustability is 
rated poorly, because space around the saddle 
was too tight and the feet did not connect to 
the pedals. Realism is rated neutral, because the 
mannequin had a clearly visible, low resolution 
polygonal mesh surface, but a good surface finish. 
Mounting and assembling are rated positively, 
because the mannequin was easy to use. It mostly 
suffered from performance issues. The participants 
mentioned several possible improvements.

Conclusion
The research questions is: “How is the 
Personalized Mannequin experienced by users?”. 
The answer is that the mannequin is experienced 
desirable overall, but suffers from practical flaws.

The mannequin model is oddly shaped near 
the bottom, head and feet, making cycling 
gear challenging to apply and tilting the 
mannequin on the bike. Attaching limbs is easy 
but the attachment interfaces itself are weak, 
disconnecting or moving during use. Limb flexibility 
is experienced positively and may be applied more 
to benefit mounting to the bicycle if modelled 
correctly. Performance, quality and adjustability 
are the weaknesses of the mannequin model and 
improvements to it will benefit the experience by 
users and increase desirability of the product.
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Figure 4.152: The Personalized Mannequin with annotations of conclusions from validation.

5. Conclusion
5.1 Recommendations

5.2 Overall Conclusion

The Mannequin in Overview

The helmet does not fit perfectly.

The mannequin is moved forward.

The suit’s sleeves are stretched.

The feet do not reach the pedals.
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Improvements to the Personalized Mannequin become apparent after validation 
with Rupert. Recommendations are presented on how to improve the product, 
as another iteration falls out of the scope of this project. The recommendations 
are structured identically to how the product features are presented in this 
report. The goal is to increase the desirability ratings for all desired criteria: 
Repeatability, Adjustability, Realism, Mounting & Assembly to make Rupert hit the 
Innovation Sweet Spot.

3D Digital Model
Realism of the mannequin is rated sufficient with room for improvement. 
Recommendations regard the resolution of the base mesh and the shape and 
size of the head.

5. Conclusion

5.1 Recommendations

Realism

1 532 4

Base Mesh Resolution
First and foremost, the base mesh resolution of the digital model must be 
improved. However, this is already performed in this project. The improved 
model was simply not ready when fabricating the full-scale prototype. The 
recommendation is to use the smoothened, uniform, triangle 50K base mesh 
presented in this report (Figure 5.1).

Head Shape & Size
The second recommendation regarding the digital model is to improve the 
head shape and size. The head shape is replaced with data from the 3D scan in 
A-pose as the quality is superior. The resulting model is manipulated to achieve 
a head circumference of the desired size. Practical helmet sizes is a leading 
requirement. Studying the international population from the DINED 1D database, 
the mean male head circumference is 570 mm. This corresponds to a medium 
size helmet for many brands (Evo Cycles, n.d.).

Rider6-Corrected

Figure 5.1: Difference between the original (left) and the final mesh (right).

GenericModelTT-Correction

Interaction Segmentation
Assembling of the mannequin is rated positively with opportunities to perfect it. 
Recommendations regard the segmentation of the legs and the bevels on the 
segment edges.

Assembling

1 532 4

Leg Segmentation
Validation shows functional limb segmentation, but applying the suit caused 
fabric to stretch near the legs. The recommendation is to shorten leg protrusion 
from the torso. The length of the protruding limb is shortened to a third of the 
upper leg length (Figure 5.2). A study with the cycling suit shows the sleeve is 
able to fold back far enough. This not only prevents the fabric from stretching, 
but makes the suit easier to apply overall.

Bevels
All segmented surfaces have a straight bevel of 2.5 mm at the edge. The 
recommendation is to decrease bevel size to 1.0 mm and to make it rounded 
instead of straight (Figure 5.3). Participants experienced the feature positively, 
but mentioned it could be smaller. A smaller bevel also more closely represents 
a realistic body shape. The bevel was originally straight because it requires 
no support during FDM 3D printing. This is no longer a requirement when the 
Personalized Mannequin is CNC milled. The suit slides over a rounded bevel 
easier than over a straight bevel.

Figure 5.3: A small, rounded bevel (above) is recommended over a large, straight 
bevel (below).

Figure 5.2: Leg protrusion from the torso is decreased from 1/2 to 1/3 of the 
upper leg length.

1/2 length

1/3 length
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Attachment Interfaces
Repeatability of the mannequin is rated sufficiently 
with room for improvement. Recommendations for 
a redesign of the Attachment Interface regard its 
shape, the magnets and integrated with the limbs.

The Attachment Interfaces are redesigned 
following validation (Figure 5.4). The performance 
did not meet requirements and several 
recommendations are therefore presented.

Integration
Third, the Attachment Interface is recommended 
to be integrated with the polyurethane limb 
instead of being attached as a separate, SLS 3D 
printed part. The design that results from iterations 
in this project does not require complex features 
that can be realized through SLS 3D printing. 
Integration with the CNC milled limbs eliminates 
unnecessary manufacturing. Attachment with 
screws becomes unnecessary and the intended 
sockets are redesigned as an extra attachment 
measure preventing slack.

Repeatability
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Shape
First, the shape of the interfaces is changed to 
improve the performance and to reduce slack. 
The recommendation is to recess the interfaces 
deeper, increasing their effective moment arm. It 
is also recommended to give the interfaces taller 
straight (albeit drafted) faces, so the male side 
does not slide out of the female slot. The bevel 
size remains identical to its original design.

Magnets
Second, it is recommended to increase magnetic 
force. This is possible by multiple methods. One is 
to use a stronger magnet. The Neodymium N50 
magnet is recommended over the common N35 
for its higher maximum strength (MagnetPartner, 
n.d.). Magnetic force is also defined by volume, so 
another method is to use larger magnets. Mostly 
thickness can be increased as the interfaces have 
a limited surface area. The area can be used more 
effectively by installing the magnets on the surface 
so they make direct contact. Appropriate adhesive 
is essential to keep the magnets in place. Figure 5.4: The recommended Attachment Interface of the arm integrated with a cylinder.

 
Bicycle Mounts
Adjustability of the mannequin is rated poorly with 
a need for improvement. Recommendations regard 
the shape and size of each mount and flexibility of 
the joints to mount them correctly.

Third, the bottom of the mannequin must allow 
more space for the saddle. The recommendation 
is to enlarge the area between the leg, specifically 
towards the back as the saddle is widest there 
(Figure 5.7). “Common bike saddle sizes range 
from 135 mm to 160 mm” (Hincapie, 2021) so the 
mannequin must be modelled accordingly.

Flexible Joints
The feet of the mannequin did not reach the 
bicycle pedals during validation. As discussed 
with the participants, the recommendation is to 
apply a flexible joint at the knees for adjustability 
(Figure 5.8). A joint in this position allows for natural 
movement. Using SLS 3D printed flexible TPU 
the joint’s flexibility can be manipulated, allowing 
for both adjustability and repeatability. Overall 
size, wall thickness and internal structures can 
be optimized to improve the joint’s performance. 
A similar joint can be applied at the elbows, but 
validation in this research did not identify such a 
requirement.

Adjustability
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Shape & Size
Similar to the head of the mannequin, its hands, 
feet and bottom did not have the intended shape 
and size. The recommendation is to manipulate 
the shape and size of each limb to their desired 
specification.

First, the hands must follow the shape of the 
handlebars more closely. This is achieved by 
modelling the fingers around a digital model of 
the handlebar (Figure 5.5). Road handlebars have 
a diameter of 23.8 mm without handlebar tape 
(Novoviç, 2021) and following that number allows 
the tape to put pressure on the fingers.

Second, the feet must be shaped and sized 
correctly to fit a cycling shoe. This challenge is 
similar to that of the head and helmet. Mean shoe 
size of the participants is 44.5, but a more practical 
size may the selected too. The recommendation 
is to model the foot slightly smaller than intended 
to apply the shoe easier and give the mannequin 
slight adjustability (Figure 5.6).

Figure 5.7: The bottom must leave enough space 
for any saddle.

Figure 5.6: The feet must be sized slightly smaller 
than the desired shoe size.

Figure 5.5: The hands must follow the shape of the 
handlebar.

Figure 5.8: A flexible knee segment allows for 
accurate adjustability.
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5. Conclusion

5.2 Overall Conclusion
The aim of this research is to increase the speed of cyclists by reducing 
aerodynamic drag. Common research methods are digital and physical 
simulations. The goal is this project is to develop an anthropometric model for 
each method based on professional cyclists from Team DSM. 

Digital Model (Generic)
The first goal of this research is to create a generic cyclist model for research 
organisations around the world. The Generic Model is an average of ten male, 
professional cyclists in both road and time trial pose (Figure 5.9). The DINED 
Mannequin approach is used to divide the method into four steps: Capture, 
Process, Correspond & Average.

The 3D scanning process in this project is challenging as the participants are 
captured in a representative context: on-site, on a bicycle in cycling gear. This 
affects the quality of the 3D scan and influences any processing of the models. 
The models are corrected for movements, missing sections and unwanted 
noise. Design of the base mesh also influences the result as it determines 
surface quality and level of detail. It is preferred to stay true to the original 
anthropometric data, but manipulation is essential for the desired result.

The Digital Human Modelling knowledge generated in this project may be 
relevant in future anthropometric research. The workflow provides insights 
into capturing a human body in the context of cycling, but it may be applied 
in a different context too. The rest of the workflow similarly describes how to 
process the anthropometric data to specific desires. Aerodynamic research is 
not the only context where this knowledge is relevant and applicable.

The Generic Model is going to be published on the 4TU Repository to perform 
comparable aerodynamic research around the world. The Generic Model 
provides a benefit to the industry by increasing knowledge about and application 
of cycling aerodynamics. A limitation of the model is its limited dataset. The 
model is based on ten riders, but the number may increase in the future. The 
model lacks quality in some places, but is an improvement over what is available.

GenericModelTT-Correction

Figure 5.9: Generic Model of ten male, professional cyclists in time trial pose.

Physical Mannequin (Personalized)
The second goal of this research is to design a personalized cyclist mannequin 
for aerodynamics researchers. The Personalized Mannequin is the physical 
representation of an individual cyclist’s anthropometry in time trial pose (Figure 
5.10). The Centre of Design for Advanced Manufacturing Approach is used to 
divide the process into four steps: Digitalization, Design Automation, Digital 
Fabrication & Production.

The Advanced Manufacturing process of Rupert is challenging as the 
Personalized Mannequin is such a large, Ultra-Personalized Product. Possibilities 
are limited as every version of the product is different and requires advanced 
materials and fabrication. CNC Milling rigid polyurethane foam provides the 
accessibility, product performance and design features Rupert requires. The 
design has segmented limbs to apply cycling gear, magnetic interfaces to attach 
limbs and flexible interfaces to mount to a bicycle. The mannequin stays true to 
the original anthropometric data, but has design features to provide the desired 
user interaction.

The Advanced Manufacturing knowledge generated in this project may be 
relevant in future Ultra-Personalized Products of this scale. The design process 
provides insights into the application of additive and subtractive manufacturing. 
Advanced Manufacturing at this scale is uncommon, especially with the level 
of detail a mannequin requires. The project elaborates on the selection of 
fabrication methods and materials which is highly relevant in this context. The 
knowledge may be applicable in other prototype or product design projects.

This project only results in one version of the Personalized Mannequin. The 
workflow is partially automated and accurately described in this report so it 
can be repeated. Rupert’s design may be of use to other organisations with 
a different anthropometric model, perhaps in a different context than cycling. 
A limitation of the design is that it is specifically designed for the context 
of aerodynamic research. Design features may not function as intended 
with a different application. The design of Rupert also has its flaws, so 
recommendations are presented in this report. If the Personalized Mannequin is 
further developed, I believe it is a well designed and valuable product.

Figure 5.10: Personalized Mannequin of an individual male, professional cyclist in 
time trial pose.
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6. Sources

6. Sources

6. Sources
This list contains all the sources referenced 
throughout this report in alphabetical order.
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Autodesk Meshmixer. (2020). Free software for 
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7. Appendix

1. Design Brief
The project brief is discussed during the project kick-off meeting on 
Wednesday 09-02-2022 and later finished completely.
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Pilot conducted on Wednesday 09-02-2022 at the 
faculty of Industrial Design Engineering, TU Delft 
with Bertus Naagen, Harm Ubbens & Wouter Terra.

Introduction
“A generic cyclist model is defined based on 
average cyclist anthropometric data. Therefore, 
the aim is to make body scans of a large group 
of elite riders to extract this average model. After 
having defined the generic cyclist model, the 
geometry is stored in the 4TU repository with 
open access to the general public. This allows 
for better comparison of cycling aerodynamic 
research among different research groups around 
the world and speed up the understanding of the 
flow around a rider and bike” (Terra, 2021).

Research goal
Establish a method to capture a cyclist’s 
anthropometric data using 3D scanning.

Method
Participants
One participant is involved in the pilot.

 • Gender:  male
 • Age:  23 years
 • Length:  187 cm
 • Weight:  80 kg
 • Cycling type: recreational road cyclist

7. Appendix 2: 3D Scanning

2.1 Pilot
Apparatus

 • Time trial bicycle
 • Bicycle trainer stand 
 • Time trial cycling kit 

 • Artec Eva handheld 3D scanner (2x)
 • Laptops with Artec Studio 16 software (2x)
 • External hard drive 
 • Head cap 
 • Rotating platform 

Stimuli
The participant is placed in position in cycling kit. 
The participant is instructed to remain still while 
being captured by the researchers for about 5 
minutes. This research involves three poses:

 • A-pose on rotating platform.
 • A-pose on the floor (Figure 7.1).
 • Time trial (TT) pose on the bicycle (Figure 

7.2).

Procedure
Location: 3D Body Scanning Lab, TU Delft
Time: participant present from 10:30-12:30

Instruction
The participant is welcomed, introduced to the 
researchers and the research overall. The informed 
consent form is explained and signed.

Preparation
 • The participant is asked to change into the 

cycling kit.
 • The bicycle is installed in the trainer stand 

and positioned in an open space.
 • The 3D scanners and laptops are connected 

and powered up (Figure 7.3).

3D Scanning
 • The participant is placed in a selected pose.
 • Two researchers capture the participant from 

left and right side of the body with handheld 
scanners.

 • Captured results are confirmed for 
completeness in the software before ending 
scanning.

 • Raw capture data is named and stored on an 
external hard drive.

 • The scanning procedure is repeated for the 
other poses.

Data processing
The collected raw data is processed in Artec 
Studio 16 software. Each file is processed using the 
following steps:

 • Editor – Eraser: unwanted elements.
 • Tools – Rough serial registration.
 • Tools – Fine registration.
 • Tools – Global registration.
 • Tools – Sharp fusion

After the initial steps, the file is saved in the 
OBJ format. The file is then combined with the 
corresponding second half of the scan. The halves 
are combined using the following steps:

 • Align – New pair (3x)
 • Align – Auto-alignment
 • Align – Non-rigid
 • Tools – Sharp fusion

A combined model is now created. Holes in the 
model may appear. These may be automatically 
filled by using settings in the ‘Sharp fusion’ tool. 
If holes are filled incorrectly, manually applying 
‘Bridges’ may help. When too many holes appear 
to fill, the subject may have to be scanned again.

Results
A-pose
The most accurate scan is produced by the 3dMD 
full-body scanner (Figure 7.4). This scan is easiest 
and fastest to perform. However, this setup is not 
available during the actual research.

Figure 7.1: Participant positioned in A-pose with a 
full-body 3dMD scanner setup.

Figure 7.2: Participant positioned in time trial pose 
on the bicycle with a handheld scanner setup.

Figure 7.3: Digital model in 3D capturing software 
on a laptop.

Figure 7.4: A-Pose model captured with full-body 
3dMD scanner.

The handheld scanner produces significantly 
different results. It is more difficult and slower 
to operate. The models generated suffer 
from incompleteness. The A-pose recorded 
using the rotating platform is a combination 
of scans, because the scanner is unable to 
record continuously (Figure 7.5). The main issue 
is capturing the arms completely. This scan is 
performed by a single researcher.
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The A-pose recorded without rotating platform 
shows a more complete scan (Figure 7.6). This 
scan is performed by two researchers with 
handheld scanners and later combined with the 
software. It is easier to perform the scan without 
the rotating platform. The model shows some 
incompleteness in the hair, trousers and inside of 
the arms. This scan is performed on a different 
participant than the other scans.

Time trial pose
The time trial pose is recorded with one method 
only: by two researchers with handheld scanners. 
Combining both halves results in quite a complete 
model that mainly lacks its feet (Figure 7.7). There 
are some holes near the bottom, hands, elbows, 
upper arms, lower legs, neck and helmet (Figure 
7.8).

Discussion
A-pose
As a full-body scanner will not be used in the 
research, two hand scanning methods are 
compared to capture the A-pose: with and without 
a rotating platform.

The automatic rotation causes the participant to 
move from the focal point of the hand scanner 
continuously. This causes errors with the capturing 
software and results in separate scans. The scans 
can be combined later, only requiring some manual 
effort. The arms and lower legs are not captured 
at all. The lower legs can be explained because the 
participant was wearing black socks. The arms are 

not captured at all as they protrude significantly 
from the body. The researcher is unable to move 
the focal point of the hand scanner fast enough. 
Therefore, the rotating platform is not the right 
tool for this job.

Capturing the participant without the rotating 
platform is more effective. However, this involves 
two researchers hand scanning each side of the 
subject. The results only show incompleteness 
in the hair, trousers and inside of the arms. The 
subject wore no head cap and had dark trousers, 
explaining these holes in the model. The inside of 
the arms was a human error as these areas are 
hard to reach. They require extra attention from 
the researchers.

Time trial pose
Capturing the participant with two researchers 
hand scanning each side of the subject is effective. 
The contours of the subject are captured 
completely and only some holes occurred in other 
areas.

Similar to the A-pose, this model lacks its feet 
because the participant wore black socks and 
shoes. The holes near the hands, elbows and 
bottom are due to contact points with the bicycle 
in these areas. They cannot be avoided. The holes 
near the helmet are due to the participant’s hair 
that was not completely covered by the head 
cap. The holes near the upper arms, lower legs 
and neck are due to human error and scanner 
limitations. These areas a hard to reach, because 
they are partially obstructed by the bicycle and 
the participant himself. They require extra attention 
from the researchers and post-processing. The 
A-pose model may be used for these corrections.

Limitations
All scans were performed on the same participant, 
except the A-pose without rotating platform. 
This means the A-pose results cannot be directly 
compared. However, the researchers noted a 
preferred workflow without the rotating platform. 
Thus a conclusion can still be drawn and the 
platform will not be used in the future.

The participant was instructed to wear a helmet 
to strike the right pose during scanning, but this 
is not desired in the generic model. The helmet 
may be used to practice the pose prior, but will be 
removed during scanning.

The participant wore black socks and shoes during 
scanning. Those were not captured successfully 
due to their colour. However, the shoes are not 
desired in the generic model. They will either 
be removed during scanning or during post-
processing in the following research.
 
Conclusion
The research goal of this report is:
Establish a method to capture a cyclist’s 
anthropometric data using 3D scanning. 

The pilot has been valuable in establishing the 
research method and it can be concluded as 
successful. A cyclist model is generated by 3D 
scanning a participant on a time trial bicycle. 
Repeating this process will produce enough data 
to generate a generic cyclist model. 

Possible improvements for the research method 
are identified and will be implemented in the 
following research. The improvements concern 
the optimal apparatus, clear stimuli and a detailed 
procedure.

Figure 7.5: A-Pose model captured on a rotating 
platform with a single handheld scanner.

Figure 7.6: A-Pose model captured without a 
rotating platform with two handheld scanners.

Figure 7.7: Captured TT pose in perspective.

Figure 7.8: Captured TT pose from the sides.

After post-processing, all holes in the model are 
filled (Figure 7.9). Inaccuracies show near the head, 
arms and lower legs (Figure 7.10). The feet still lack 
as these cannot be borrowed from the A-pose 
model.

Figure 7.9: Processed TT pose in perspective.

Figure 7.10: Processed TT pose from the sides.
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7. Appendix 2: 3D Scanning

2.2 Briefing
Introduction
The research goal is to create a generic 
cyclist model for the purpose of aerodynamic 
investigation. The generic cyclist model is defined 
based on the average cyclist anthropometric 
data. Therefore, the aim is to make body scans 
of a large group of elite riders to extract this 
average model. After having defined the generic 
cyclist model, the geometry will be stored in the 
4TU repository with open access to the general 
public. This allows for better comparison of cycling 
aerodynamic research among different research 
groups around the world and speed up the 
understanding of the flow around a rider and bike.

Method
Procedure
The participants are introduced to the research. 
They are given an informed consent form they 
are asked to read and sign. The researchers ask 
demographic information about the participant and 
take manual body measurements.

The participant changes into cycling kit. The 
research involves 3D scanning each participant in 
several poses (Figure 7.11). The complete session 
takes about an hour for each participant.

 • A-pose (standing up, arms & legs spread).
 • Riding pose on time trial bicycle.
 • Riding pose on road bicycle.

Data collection
Prior to scanning, demographic information 
is asked about the participants. Manual body 
measurements are also taken.

This research captures data using two handheld 
Artec Eva 3D scanners. Two researchers operate 
a device each and scan a side of the participant’s 
body. The data is processed by computer 
software to create a 3D model of the participant. 
The average of the personal models is calculated 
to generate a generic cyclist model.

Data analysis
The data of the individual scans is not shared with 
anyone outside of the project team except the 
person of the corresponding cyclist team. TU Delft 
is the only institution involved. As such TU Delft 
will follow the Personal Research Data Workflow 
to ensure GDPR compliance about the collection 

and processing of human participants. The raw 
measurements, derived datasets, and finalized 
model will also be under TU Delft IP. The generic 
cyclist model (anonymized data) will be shared 
openly with the research and cyclist industry.

Participation
Responsible researchers

 • Harm Ubbens (Team DSM)
 • Siward Vloemans (graduate student)
 • Wouter Terra (aerodynamics)
 • Bertus Naagen (3D scanning)
 • Toon Huysmans (human modelling)

Participants required
A variation of at least 20 professional cyclists 
(gender, length, weight, type of rider, etc.).

Advantages of participation
 • Experience participation in an academic 

anthropometric research.
 • Learn about the process of 3D scanning 

human subjects.
 • Helping student and researcher in the 

development of cyclist aerodynamics.

Risks of participation
The risk is that the digital geometrical and 
anthropometric data of the participant on his/
her bike is shared outside the project group and 
used for purposes, other than described in this 
document. This risk is mitigated by 1) keeping the 
amount of people involved in this project as small 

as possible, 2) only including TU Delft staff and 
3) the data management plan that is in place and 
approved by the ethical committee of TU Delft.

The possibility exists that one of the researchers 
conducting the study infects the participant with 
the COVID-19 virus, despite the measures taken. 
The latter measures taken by the research team 
to mitigate the risk of infection are as prescribed 
by the RIVM at the time of the study (e.g. wearing 
facemasks, no physical contact, limited amount of 
people in one room).

Withdrawal from participation
The cyclists can withdraw from the study at any 
time by sending an email to the research team. 
The participants have the right to be forgotten at 
any time; they can exert this right by sending an 
email to the research team.

Contact
Location
Keep Challenging Center
Anemoonstraat, 6134 TH Sittard

Contact person
Harm Ubbens

Figure 7.11: 3D Scanning a participant on a TT 
bicycle.
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All participants involved in this project are briefed 
and asked to sign an informed consent form.

7. Appendix 2: 3D Scanning

2.3 Informed Consent
Informed consent form 

 
Author :  Wouter Terra (w.terra@tudelft.nl) 
-------------------------------------------------------------------------------------------------------------------- 
 
The information sheet, accompanying this informed consent form, describes the nature of the 
present study. Please read this carefully before filling out the present form.  
 

Consent Form for Generation of a Generic Cyclist Model 
  

Please tick the appropriate boxes Yes No  
Taking part in the study    
I have read and understood the study information dated [DD/MM/YYYY], or it has been read 
to me. I have been able to ask questions about the study and my questions have been 
answered to my satisfaction. 
 

  

I consent voluntarily to be a participant in this study and understand that I can refuse to 
answer questions and I can withdraw from the study at any time, without having to give a 
reason.  

  
 



I understand that taking part in the study involves the collection of my body geometry, 
standing and sitting on a bike, manually using measurement tape and by 3D body scanning. 
 

 
 

 
 



I understand that taking part in the study involves the following risks:  
Great care is taken to secure the personal body geometry data of the participants. 
Nevertheless, a small risk remains that this personal anthropometric data comes into the 
hands of others than the team of people involved in this study. Note, that this risk is mitigated 
by limiting the amount of people involved in this study, that all people in this study that will 
see this personal data are staff of the TU Delft and that latter are aware and should act as is 
described in the TU Delft data management plan as approved by the ethical committee of the 
university. 
 

   

The possibility exists that one of the researchers conducting the study might infect me with 
the COVID-19 virus, despite the measures taken. The latter measures taken by the research 
team to mitigate the risk of infection are as prescribed by the RIVM at the time of the study 
(e.g. wearing facemasks, no physical contact, limited amount of people in one room). 

   

 
Use of the information in the study 

   

I understand that information I provide will be used for the generation of a generic cyclist 
model by aggregating the geometries of all participants in this study. This generic model will 
be shared openly with the scientific community and cycling industry. The personal geometries, 
obtained by the body scanning, might be used anonymously (excluding large parts of the body, 
head among others) only to elucidate the procedure of processing the individual scans into the 
final generic model. Never will any data be shared outside the project group that can be 
traced back to individual participants. 
In addition to making the generic cyclist model freely available, the present research will be 
presented at conferences (e.g. ISEA conference) and published in scientific journals (e.g. 
journal of biomechanics, wind engineering & industrial aerodynamics). 
 
 

 
 

 
 



I understand that personal information collected about me that can identify me, such as my 
personal geometry and anthropometric data, will not be shared beyond the study team.  

 
 

 
 



Future use and reuse of the information by others    
I give permission for the geometry and anthropometric data that I provide to be archived in 
the TU Delft project repository so it can be used for future research and learning. The data will 
be deposited in the form of stl and ASCII files (defining the geometry) and Microsoft Excel files 
listing the participants anonymously including their length, weight, gender etc. 
Apart from the project team, only one of the people of the collaborating cycling team can 
access the data of the participants of his/her cycling team. 

 
 
 
 
 
 

 
 
 
 
 



Signatures    
 
_____________________                       _____________________ ________  
Name of participant [printed] 
 
and legal representative If applicable)                        Signature                 Date 

   

For participants unable to sign their name, mark the box instead of sign 
 
 
I have witnessed the accurate reading of the consent form with the potential participant and 
the individual has had the opportunity to ask questions. I confirm that the individual has given 
consent freely. 
 
__________________________             _______________________    _________ 
Name of witness          [printed]               Signature                                     Date 

   

I have accurately read out the information sheet to the potential participant and, to the best 
of my ability, ensured that the participant understands to what they are freely consenting. 
 
________________________  __________________         ________  
Researcher name [printed]  Signature                 Date 
 

   

Study contact details for further information:  [Name, phone number, email address] 
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Combining & Automizing
In advanced manufacturing, fabrication techniques 
are often combined. Each one has its own 
strengths and weaknesses, so every product 
feature has its own optimal method. By making 
design decisions and effective fabrication 
combinations, manufacturing may become almost 
automized. Despite that posing a challenge, it is a 
great goal to work towards as well.

 
Finish
Digitally fabricated products often require finishing. 
3D Prints in particular may have a rough surface 
that requires finishing. Various techniques exist 
and testing product sections with different ones 
can be effective to reach the desired finish. Thick 
automotive paint is an example that can directly 
finish a rough surface and provide the right colour. 
Spray cans are often thinner and fail to do so.

Mannequins
“Wout van Aert’s mannequin is finished so 
smoothly, it was probably fabricated using a 
different method altogether. Using a negative 
cast and a gel coat layer, glass or carbon fibre 
sheets can enforce a shape on the inside with 
an incredibly smooth finish on the outside. This 
process is used to create the hull of small boats, 
for example.”

7. Appendix 3: Interviews

3.1 Advanced Manufacturing
Interview with TU Delft’s advanced manufacturing 
expert Sander Minnoye on Monday 28-02-2022.

The following steps explain the process of 
Advanced Manufacturing from 3D scanning to 
finishing. Additional information was added from 
the ’Personalized product design through digital 
fabrication’ booklet.

“Agile manufacturing refers to the ability for a 
company to adapt quickly to the customer’s 
demand, to the technology evolution and more 
generally, to react positively to the variation 
of the market.” (CDAM). The Centre of Design 
for Advanced Manufacturing lab identifies four 
directions: Digitalization, Design Automation, Digital 
Fabrication and Human-Robot Coproduction. 
Digital Fabrication is the direction used to realize a 
product.

Digital Fabrication
In ultra-personalization enabled by Industry 4.0, 
products are always digitally fabricated. Digital 
fabrication fits well with 3D scanning and both are 
embedded in the computational design process. 
“Designers need to create flexible and knowledge-
based designs that can be seamlessly integrated in 
the design to manufacturing workflow.”

Additive Manufacturing
3D Printing
Possibly the most discussed digital fabrication 
method in recent years is 3D printing. It  is unique 
because it functions by adding material rather 
than subtracting it. Fused Deposition Modelling 3D 
printers have become commercially available for 
home use. However, FDM printing is no production 
method. The process requires manual operation 
and frequently fails. Advanced industrial 3D printers 
exist with variations of the FDM technique. These 
are often useful for fine product details.

Example: Oceanz is an example company that 
takes 3D printing to an industrial level. They deliver 
3D printed products that are certified for food, 
medical and industrial. 3D Files can be uploaded 
online with the desired finish and Oceanz delivers 
the product to the customer’s doorstep.

 
Subtractive Manufacturing
CNC Milling
Milling on 5-axis CNC is a fast digital fabrication 
method that can be used on a variety of materials. 
Creating shapes out of a block of material, CNC 
milling relies on subtracting amounts of material. It 
is fast and accurate, but sometimes limited by the 
access to complex shapes. Results often do not 
need a finish.

Polyurethane is a foam commonly used for CNC 
milling. It has dense variants that feel like a solid 
rather than a foam. Its rigid characteristics make it 
a viable option for a personalized mannequin.

Example: Haas Automation is an example company 
that produces CNC Milling machines requiring no 
manual labour. The machines can validate their own 
accuracy and results. Besides vertical, horizontal 
and 5-axis capabilities, their machines can be fully 
integrated with automation options.

Sheet Manufacturing
Laser cutting is an example of sheet manufacturing, 
by far the most common digital fabrication 
method. Sheet manufacturing has been applied for 
years and has proven to be extremely effective. 
The method involves cutting a shape from a 2D 
material sheet, often processed into a 3D product. 
That particular characteristic is also its most limiting 
one, complex 3D shapes are hard to create.

Example: 247TailorSteel is an example company 
that has completely automized their sheet 
manufacturing process. The website takes 
production jobs and is able to calculates costs 
directly. Manufacturing including assembly and 
painting is completely automated.
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The starting point of this pressure cooker is a 
preliminary list of requirements resulting from the 
initial research phase. The pressure cooker runs 
through the creative process of the project in a 
short time of three days. This method has the 
following goals:

 • Identify assumptions & knowledge gaps.
 • Identify opportunities & bottlenecks.
 • Evaluate project planning & methods.

Ideation
Goal: Generate as many ideas as possible.
Method: How-To’s & Design Drawing.

Design challenges in this project are defined as: 
body segmentation, limb attachment, mounting 
points and digital fabrication. These challenges 
are used to create How-Tos. Three How-Tos are 
created to ideate about mounting points more 
in-depth.

7. Appendix 4: Pressure Cooker

4.1 Ideation
7. Appendix 3: Interviews

3.2 Digital Human Modelling
Online interview with TU Delft’s digital human 
modelling assistant professor Toon Huysmans on 
Tuesday 22-02-2022.

The following steps explain the process of digital 
human modelling from 3D scanning to mannequin 
design. Additional information was added from 
the ‘1D to 4D Anthropometry’ tutorial lecture 
(Huysmans, 2020).

Capture 3D Model (Artec Studio 12)
Scan the participants without helmet and shoes 
preferably, or post-process using software. Take 
3-5 relevant body measurements per participant 
for reference. Ask each participant for cycling kit 
size to make a representative 3D model. No hole-
filling in Artec Studio, only basic editing such as 
section pairing and noise removal.

Edit Wrap Template (Blender)
Select wrap template from Wrap3D database 
in A-pose. Approximate cycling pose by making 
manual adjustments in Blender. This is the 
reference to interpret the 3D scans with. The 
reference may contain a bias, so the template may 
later be replaced by the generic model.

Apply Wrap Template (R3DS Wrap3)
A wrap template reference is applied to raw 
3D scans to make the models corresponding in 
R3DS Wrap3. The models are now automatically 
interpretated, filling any holes if necessary and 
recognizing landmarks such as facial features and 
body parts. This is also called ‘retopology’.

Scientific Visualization (Paraview plug-in)
Requires a population of corresponding 3D models 
for scientific visualization. Import custom filter in 
the Tools menu of Paraview. Align & Compute 
Average / Shape function to generate a generic 3D 
model. After this step, the generic model may be 
used as reference template to make an iteration of 
model correspondence. This will remove reference 
bias caused by the edited wrap template.

Articulate Limbs (Mixamo)
Apply an articulating skeleton to the 3D model 
in Mixamo. Stock movement animations can be 
directly applied from the library.

 
Geometric Operations (Rhino & Grasshopper)
Visual programming language to apply geometric 
operations to a 3D model. The operations can be 
repeatedly applied to different models because of 
the automated structure.

Figure 7.12: How-To segment a body.



Cyclist Mannequin - Siward Vloemans 143Cyclist Mannequin - Siward Vloemans142

Figure 7.13: How-To attach limbs. Figure 7.14: How-To digitally fabricate.
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Figure 7.15: How-To mount hands to handlebar. Figure 7.16: How-To mount feet to pedals.
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Goal: Form detailed concepts based on ideas.
Method: Morphological Chart & Design Drawing.

After generating solutions for each design 
challenge using How-Tos, a Morphological Chart is 
used to structurally generate concepts. Each How-
To forms a row in the chart and the ideas fill the 
columns. First, the Morphological Chart is used to 
identify where competitors sit in the solution space 
(Figure 7.18). Second, it is used to combine ideas 
in a new way (Figure 7.19). Four idea combinations 
are made, ranging from ‘first thought’ to ‘weird’ 
combos. The combinations are developed into 
complete concepts (Figure 7.20).

Before selection of a concept, the concepts 
are detailed further by force-fitting two pairs of 
concepts together (Figure 7.21 & Figure 7.22). This 
creates more refined products than direct results 
from the Morphological Chart. One of the concepts 
can be chosen using a selection method. However, 
a combination of the final two concepts is made 
instead (Figure 7.23).

7. Appendix 4: Pressure Cooker

4.2 Conceptualization

Figure 7.17: How-To mount bottom to saddle.

Figure 7.18: Morphological Chart of competitors.
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Figure 7.19: Morphological Chart of new idea combinations. Figure 7.20: Four developed concepts.
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Figure 7.21: Force-fitted concept combination (1/2). Figure 7.22: Force-fitted concept combination (2/2).
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Goal: Develop a chosen concept.
Method: Product Prototyping.

Introduction
Magnets as a method to attach limbs to the 
mannequin are frequently recurring in this pressure 
cooker. The goal of this test to learn more about 
the application of magnets in this context.

Research question
‘How are magnets best applied as an attachment 
method?’

Method
Participants
No participants are involved in the research.

Apparatus
The prototypes used for this research are made at 
home using some simple tools (Figure 7.24).

 • Wooden blocks (100 x 44 x 18 mm)
 • Wooden rods (ø 8 x 20 mm)
 • Neodymium ring magnets N50 (ø 10 x 3 mm)
 • Steel screws (ø 2.5 x 12.5 mm)

 • Drill & drill bits
 • Screwdriver
 • Sanding paper

7. Appendix 4: Pressure Cooker

4.3 Development

Stimuli
Seven magnet attachment interfaces are 
prototyped (Figure 7.25). Each interface consists 
of two corresponding blocks, resembling the limbs 
to be attached. Every interface has a different 
combination of magnets, pins & holes. All interface 
combinations of 1-3 different elements are 
prototyped.

Procedure
Each interface is attached & detached five times 
consecutively. The researcher rates the attachment 
on three criteria about freedom of movement: 
attachment force, rotation and sliding. A scale from 
0-2 is used to indicate no performance at all to 
good performance.

Data analysis
As only limited data is collected in this research, 
no extensive analysis is conducted. Ratings of 
the different prototypes are directly compared 
and the results used to identify product feature 
characteristics.

Results
The performance ratings of the attachment 
interfaces can be found in Figure 7.26. It is clear 
that performance increases as more attachment 
points are included in the interface. Where 
interfaces #1 and #2 both only score points for 
one criteria, interfaces #3 and #4 score points 
for two criteria and interfaces #6 and #7 score 
points for all three. Interface #5 is an outlier, only 
scoring points for strength. Based on these results, 
interface #6 (Figure 7.27) is the best attachment 
method, scoring maximum points for each criterium 
except attachment force.

Figure 7.25: Prototyped attachment interfaces 
numbered #1-7 from top-left to bottom-right.

Figure 7.24: Materials used to create the 
prototypes.

Figure 7.23: Final, combined product concept. 
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Discussion
The performance ratings show a correlation with 
the amount of attachment points on the interface. 
One rod prevents sliding. Two rods also prevent 
rotation. One magnet provides force and two 
magnets provide twice as much, as explained 
below.

The ideal attachment interface limits movement on 
all axes. Magnets ensure the attachment position 
is not completely fixed: they will detach if enough 
force is applied. The amount of required force is 
equal to the strength of the magnets, adding up 
linearly. This is why interface #5 and #7 perform 
best with this criterium: they utilize two magnets to 
create double the force.

To apply magnets as an attachment method, 
movement along the other axes must be blocked. 
A rod only limits movement in a single direction as 
it can rotate in its slot. This is why interface #4 and 
#6 perform best with this criterium: they utilize two 
rods to block sliding and rotation.

Limitations
This research is limited by some inaccuracies in 
prototyping. All wooden objects are hand sawn, 
sanded and drilled. The magnets installed are not in 
direct contact, limiting their effectivity. Furthermore, 
only round pin connections are used. Follow-up 
research could include different shapes as well.

 
Conclusion
To conclude this research, the research question is 
repeated:

‘How are magnets best applied as an attachment 
method?’

The answer to the research question is that 
magnets are best applied as an attachment 
method to non-permanently fix a position along 
one axis. Limiting freedom of movement along two 
axes by using shape-fit, magnets can be applied to 
set a force threshold for detachment.

# Force Rotation Sliding

1 0 0 2

2 1 0 0

3 1 1 0

4 0 2 2

5 2 0 0

6 1 2 2

7 2 1 2

Figure 7.26: Interfaces rated on attachment 
performance.

Figure 7.27: The best scoring interface #6.
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Process Sub-process Sub-process   Requirement / Desire Remarks 
1 Originate 1.1 Select 1.1.1 Select human subject 1.1.1.1 The subject is informed about data collection & analysis.   

      1.1.2 Select bicycle 1.1.2.1 The subject's personal bicycle geometry is used.   
                  
   1.2 Capture 1.2.1 3D scan human subject in A-pose 1.2.1.1 The subject positions feet below shoulders & arms separated.   

      1.2.2 
3D scan human subject in road 
bicycle pose 1.2.2.1 The subject holds the handlebar deep in the drops.   

      1.2.3 
3D scan human subject in time 
trial bicycle pose 1.2.3.1 The subject holds the handlebar ends with separate hands.   

                  

   1.3 Process 1.3.1 Align model scans sections 1.3.1.1 The model scan sections overlap.   

      1.3.2 
Correspond model with mesh 
template - -   

      1.3.3 
Replace inaccurate model body 
parts - -   

                  

   1.4 
Automate 
design 1.4.1 Segment model 1.4.1.1 The mannequin's body segments are parametrically defined.   

      1.4.2 Apply model design features 1.4.2.1 The mannequin's design features are parametrically defined.   
                  

   1.5 Source 1.5.1 Source raw materials 1.5.1.1 The mannequin's raw materials are commonly available.   

      1.5.2 Source stock components 1.5.2.1 The mannequin's stock components are commonly available.   
                  

   1.6 
Fabricate 
digitally 1.6.1 

Digitally fabricate custom 
components 1.6.1.1 The mannequin's custom components are quickly fabricated.   

      1.6.2 Finish custom components - -   
                  

   1.7 Produce 1.7.1 Assemble components 1.7.1.1 The mannequin's production method is commonly available.   

         1.7.1.2 The mannequin's production method is automated.   

         1.7.1.3 The mannequin's production method is accessible worldwide.   
         1.7.1.4 The mannequin is cost efficient.   

      1.7.2 Package - -   
                  
2 Distribute 2.1 Contract 2.1.1 Data security 2.1.1.1 The subject's 3D scan data is privately stored.   

         2.1.1.2 The subject's 3D scan data is anonymously stored.   
                  

   
2.
2 Deliver 2.2.1 Collect from supplier 2.2.1.1 The mannequin is fabricated nationally.   

      2.2.2 Deliver to customer 2.2.2.1 The mannequin is delivered by national postal service.   
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3 Use 3.1 Store 3.1.1 Place in warehouse rack 3.1.1.1 The mannequin is scratch resistant.   

      3.1.2 Store in warehouse rack 3.1.2.1 The mannequin is temperature resistant from -10 °C to 40 °C.   
                  

   3.2 Transport 3.2.1 Carry to car 3.2.1.1 The mannequin is lighter than 16 kg. Maximum lifted weight for a woman. 

         3.2.1.2 The mannequin consists of few separate parts.   
      3.2.2 Transport by car 3.2.2.1 The mannequin disassembles space-efficiently.   

      3.2.3 Carry to wind tunnel 3.2.3.1 The mannequin is light.   
                  
   3.3 Assemble 3.3.1 Assemble in road position 3.3.1.1 The mannequin can be assembled by a single adult.   

      3.3.2 Assemble in time trial position 3.3.2.1 The mannequin can change torso & arm position. Main differences in bicycle position. 

      3.3.3 Re-assemble in between tests 3.3.3.1 The mannequin's limbs are quickly (dis)assembled.   
                  

   3.4 Dress 3.4.1 Dress in cycling suit 3.4.1.1 The mannequin has detachable arms & legs. Cycling suits are tight, one-piece. 
      3.4.2 Dress in cycling socks 3.4.2.1 The mannequin has bare feet & lower legs. Cycling socks reach halfway the lower leg. 

      3.4.3 Dress in cycling shoes 3.4.3.1 The mannequin has smoothened feet. Cycling shoes have stiff soles. 

      3.4.4 Dress in cycling helmet 3.4.4.1 The mannequin has a bald head. Cycling aero helmets cover the neck. 
      3.4.5 Dress in cycling glasses 3.4.5.1 The mannequin has facial features. Cycling glasses rest on nose and ears. 

      3.4.6 Change outfit in between tests 3.4.6.1 The mannequin has a smooth surface. To slide clothes over. 
                  

   3.5 Mount 3.5.1 Mount to road handlebar 3.5.1.1 The mannequin holds parallel ⌀ 35 mm Road bars with its hands. Standard ⌀ 31.8 mm plus handlebar tape. 

      3.5.2 Mount to time trial handlebar 3.5.2.1 
The mannequin holds parallel ⌀ 25 mm TT bars with separate 
hands. Standard ⌀ 22.2 mm without tape. 

      3.5.3 Mount to bicycle saddle 3.5.3.1 The mannequin has a 165 mm open area between the legs. Standard saddle width 165 mm maximum. 

      3.5.4 Mount to bicycle pedals 3.5.4.1 The mannequin twists its legs. Cycling shoe cleat-pedal system. 

      3.5.5 Re-mount in between tests 3.5.5.1 The mannequin is quickly (un)mounted.   

      3.5.6 
Mount to different bicycle 
geometry 3.5.6.1 The mannequin has limited joint flexibility.   

         3.5.6.2 The mannequin's pose is accurately adjustable.   
                  
   3.6 Test 3.6.1 Test in wind tunnel 3.6.1.1 The mannequin's shape represents its subject.  
         3.6.1.2 The mannequin's shape is accurately realistic.   

         3.6.1.3 The mannequin's seams are unobtrusive.   

         3.6.1.4 The mannequin is rigid on the bicycle. Common wind testing speed 50 km/h. 

         3.6.1.5 The mannequin is rigid on the bicycle while wobbling sideways. Caused by wind speeds. 
         3.6.1.6 The mannequin's pose is accurately repeatable.   

      3.6.2 
Test with Particle Image 
Velocimetry 3.6.2.1 The mannequin has a matte, black colour finish. Absorbs laser light rays. 

         3.6.2.2 The mannequin is water resistant up to IPX4. Resistant to water splashes. 
                  

   3.7 
Use 
unintended 3.7.1 Drop on the floor 3.7.1.1 The mannequin is impact resistant up to 1.5 m. Height on bike & when carrying. 

                  

   3.8 Repair 3.8.1 Replace limbs 3.8.1.1 
The mannequin's custom components are individually 
manufactured.   

      3.8.2 Replace stock components 3.8.2.1 The mannequin's stock components are individually sourced.   
                  

32 
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4 Discard 4.1 Disassemble 4.1.1 … 4.1.1.1 
The mannequin's stock and custom components are 
separatable.   

                  

   
4.
2 

Reuse intact 
parts  … 4.2.1.1 The mannequin is durable.   

                  

   4.3 
Recycle 
materials  … 4.3.1.1 The mannequin's custom components are recyclable.   

                  

   
4.
4 

Discard 
broken parts  … 4.4.1.1 The mannequin has low environmental impact.   

                  

Figure FIXME: Complete Product Life Cycle and List of RequirementsFigure 7.28: Complete Product Life Cycle and List of Requirements.
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7. Appendix

6. Personal Reflection
At the end of this project, I look back at the original 
learning goals from the Project Brief. The leaning 
goals are:

 • Experience the cycling industry.
 • Learn about Digital Human Modelling & 

Advanced Manufacturing.
 • Manage a design process.

The learning goals are reflected upon with the Kolb 
Learning Cycle. The method divides the learning 
cycle into four stages: Concrete Experience, 
Reflective Observation, Abstract Conceptualization 
& Active Experimentation (McLeod, 2013). All four 
stages are discussed for each learning goal.

Experience the cycling industry.
Concrete Experience
At multiple moments in this project I felt challenged 
by the competitive nature of the cycling industry. 
My case owners had a great attention to detail and 
challenged me in the same way. I tried to bring this 
project to a higher level by involving third parties 
in the development of the mannequin. However, 
budget was a limitation in instances and often 
limited the possibilities. As a result, the full-scale 
mannequin is completely manufactured by myself 
and that affected the quality of the prototype and 
advancement of the research.

Reflective Observation
I experienced the cycling industry as competitive, 
result-focussed but limited by a budget. Science 
plays an important role in professional cycling as 
differences are marginal. There is great attention 
to detail and a strive to perfection. However, I felt 
the financial means often did not align with the 
ambitious goals. In these scenarios I sometimes 
attempted to find an impossible solution, but in 
the end the case owners make the decision by 
granting the budget or not.

Abstract Conceptualization
Professional sports generate revenue by 
sponsorships and competition prizes. The result 
is all expenses must be substantiated and they 
are generally kept to a minimum. In this scenario 
it would be better to study if expectations at 
the start of the project are realistic or not. In my 

project, this became apparent about halfway the 
project and it proved challenging for me to act 
accordingly and manage expectations with my 
case owners correctly.

Active Experimentation
In future projects, I aim to gain an understanding 
of expectations early in the project and to reflect 
if those are realistic. I personally must realize if 
the goals are realistic and I must communicate 
those thoughts with all relevant stakeholders. If the 
expectations are not realistic, I must act on time 
instead of postponing the moment until late in the 
project.
 
Learn about Digital Human Modelling (DHM) & 
Advanced Manufacturing (AM).
Concrete Experience
I experienced DHM and AM as interesting, exciting 
and challenging. At the start of the project I 
was unfamiliar with these fields. Nonetheless, 
they sparked my interest and the countless 
opportunities made it lots of fun to work in these 
fields. I received lots of help from my supervisors 
and others in the faculty. However, near the end 
of the project my inexperience became apparent 
as the full-scale mannequin proved challenging to 
manufacture and had flaws that could have been 
avoided.

Reflective Observation
Looking back, I learned a great deal about 
DHM and AM. I had never used a handheld 3D 
scanner before and this project instantly involved 
challenging 3D scan subjects. The project also 
introduced me to possibly ten types of software 
I had never used before. The same went for 
all digital fabrication involved. That makes it 
explainable why I made errors during the project 
and I believe they are a rightful part of my learning 
process.

Abstract Conceptualization
Although I believe my learning process regarding 
DHM and AM has its rightful place in this project, 
they did not have to influence my full-scale 
prototype as much. A lot of activities involves in 
that process were new to me, but I could have 
used the opportunity to perform some of them 
earlier on in the project. That would be a lesson I 
take into future projects, as they will always involve 
new challenges and lessons for me.

Active Experimentation
In the future, I hope to keep learning about new 
fields in design to me, such as DHM and AM in this 
project. It is exciting to set such challenges and to 
learn as much However, I aim to experiment more 
with individual aspects of such fields throughout 
the project. Errors and lessons are always involved, 
but by facing those earlier in a process, I can apply 
those lessons to improve my end result.
 

Manage a design process.
Concrete Experience
Managing such a large design project individually 
was an exciting challenge to me. I like to concern 
about structure and planning, but I am eager to 
learn about how to apply it effectively. I used a 
flip-chart day-to-day planning with post-its holding 
points of action, meetings and milestones. I took 
a moment at the start of each day to prepare 
my activities. I took a moment at the end of each 
day to reflect on my activities and to adjust my 
planning accordingly. It worked effectively to give 
me a feeling of control and to motivate me in my 
activities.

Reflective Observation
Looking back, I am impressed I managed my 
structure all the way though to the end, not only in 
my planning but in my structure overall. I received 
many compliments throughout my project and it is 
something I am proud of. It gave structure to hold 
onto when feeling lost, but in some way it may 
have limited me when it would have been better to 
adjust the structure or planning. It sometimes felt 
as a given, but in reality it can be adjusted at any 
moment.

Abstract Conceptualization
In the future I wish to use my project management 
skills more and to develop them further. I hope to 
challenge myself by conceiving set structures more 
as fluent, able to change when a project needs it. 
I aim to use physical methods such as flip-charts 
and post-its more, because it is a distractions from 
screens and an effective communication method.

Active Experimentation
In future projects, I aim to develop my project 
management not only in individual projects, but 
in the context of a group too. During my thesis, I 
could make all decisions myself and mostly had to 
communicate them with my stakeholders. In group 
projects, all decisions are made together and that 
involves new challenges. I hope to learn about 
those experiences and see if my methods lend 
itself to become a project lead someday.



“It never gets easier,
you just go faster”

Greg LeMond


